## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Book</td>
<td>v</td>
</tr>
<tr>
<td>What's New in SAS Human Capital Management 5.2</td>
<td>vii</td>
</tr>
<tr>
<td>Accessibility</td>
<td>ix</td>
</tr>
</tbody>
</table>

**Chapter 1 • Getting Started with SAS Human Capital Management**                      | 1    |
| What Is SAS Human Capital Management?                                    | 1    |
| Log On to SAS Human Capital Management                                   | 2    |
| About the Home Page                                                      | 2    |
| The Tasks List                                                           | 3    |
| The Manage List                                                          | 4    |
| The Shortcuts List                                                       | 5    |
| The General Search Utility                                               | 5    |
| The SAS HCM Content Portlet                                             | 5    |
| User Customizations                                                      | 6    |

**Chapter 2 • The General Search Utility**                                      | 7    |
| Performing a General Search                                              | 7    |
| Working with the Search Results                                          | 14   |
| Graphing the Search Results                                              | 15   |

**Chapter 3 • The Workspace**                                                | 25   |
| About the Workspace                                                       | 25   |
| Managing Content in the Workspace                                        | 27   |
| Setting Document and Folder Properties                                   | 30   |
| Managing Alerts                                                          | 32   |

**Chapter 4 • The Employee Browser**                                          | 35   |
| About the Employee Browser                                               | 35   |
| Using the Employee Browser                                               | 37   |
| Searching for Employees                                                  | 42   |
| Customizing an Employee Profile                                          | 47   |

**Chapter 5 • Organization Analysis**                                         | 49   |
| About Organization Analysis                                              | 49   |
| Create an Organization Analysis                                          | 53   |
| Work with an Organization Analysis                                       | 55   |
| Modify the Organization Structure                                        | 58   |

**Chapter 6 • Geographic Analysis**                                          | 63   |
| About Geographic Analysis                                                | 63   |
| Create a Geographic Analysis                                             | 67   |
| Filter a Geographic Analysis                                             | 69   |
| Print a Geographic Analysis                                              | 70   |
| Export a Geographic Analysis                                             | 70   |
| Copy a Geographic Analysis                                               | 70   |
| Customize a Geographic Analysis                                          | 71   |

**Chapter 7 • Viewing the Standard Reports**                                   | 75   |
<p>| About the Standard Reports                                               | 75   |</p>
<table>
<thead>
<tr>
<th>Chapter 8 • Forecasting in SAS Human Capital Management</th>
<th>85</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Forecasting</td>
<td>85</td>
</tr>
<tr>
<td>Run a Forecasting Report</td>
<td>86</td>
</tr>
<tr>
<td>Chapter 9 • Displaying Key Metrics with SAS BI Dashboard</td>
<td>91</td>
</tr>
<tr>
<td>About SAS BI Dashboard</td>
<td>91</td>
</tr>
<tr>
<td>Creating a BI Dashboard Project</td>
<td>91</td>
</tr>
<tr>
<td>Viewing the Project</td>
<td>95</td>
</tr>
<tr>
<td>Chapter 10 • Creating Reports with SAS Web Report Studio</td>
<td>97</td>
</tr>
<tr>
<td>Using SAS Web Report Studio</td>
<td>97</td>
</tr>
<tr>
<td>Create a Report</td>
<td>98</td>
</tr>
<tr>
<td>Edit the Sample Report</td>
<td>103</td>
</tr>
<tr>
<td>View the Sample Report</td>
<td>105</td>
</tr>
<tr>
<td>Chapter 11 • Multidimensional Analysis</td>
<td>107</td>
</tr>
<tr>
<td>Overview of Cubes and Information Maps</td>
<td>107</td>
</tr>
<tr>
<td>Open and View the Data</td>
<td>108</td>
</tr>
<tr>
<td>Chapter 12 • Metrics and Scorecards</td>
<td>109</td>
</tr>
<tr>
<td>Using SAS Strategy Management</td>
<td>109</td>
</tr>
<tr>
<td>Create a Scorecard</td>
<td>109</td>
</tr>
<tr>
<td>Define a Range of Values for a Dashboard</td>
<td>111</td>
</tr>
<tr>
<td>Create a KPI for the Scorecard</td>
<td>112</td>
</tr>
<tr>
<td>View the Data</td>
<td>113</td>
</tr>
<tr>
<td>Link to a Document from a Scorecard</td>
<td>114</td>
</tr>
<tr>
<td>Link to a Scorecard from an Organization Analysis</td>
<td>115</td>
</tr>
<tr>
<td>Create a KPI Portlet</td>
<td>115</td>
</tr>
<tr>
<td>Chapter 13 • Participating in the Budgeting Process</td>
<td>117</td>
</tr>
<tr>
<td>Overview of SAS for Workforce Planning &amp; Budgeting</td>
<td>117</td>
</tr>
<tr>
<td>Working with Supplemental Schedules</td>
<td>118</td>
</tr>
<tr>
<td>Appendix 1 • Metrics in SAS Human Capital Management</td>
<td>121</td>
</tr>
<tr>
<td>Introduction</td>
<td>121</td>
</tr>
<tr>
<td>Organizational Effectiveness</td>
<td>122</td>
</tr>
<tr>
<td>Human Resources Structure</td>
<td>124</td>
</tr>
<tr>
<td>Compensation</td>
<td>126</td>
</tr>
<tr>
<td>Benefits</td>
<td>128</td>
</tr>
<tr>
<td>Separations</td>
<td>129</td>
</tr>
<tr>
<td>Staffing</td>
<td>135</td>
</tr>
<tr>
<td>Training and Development</td>
<td>141</td>
</tr>
</tbody>
</table>

Index                                            145
About This Book

Audience

What's New in SAS Human Capital Management 5.2

Overview

SAS Human Capital Management 5.2 includes new and enhanced features to help you analyze your workforce, measure performance, and produce reports based on regulatory or organizational needs. For more information about the newest SAS Human Capital Management features, see “New and Enhanced Features” on page vii.

New and Enhanced Features

The following features are new or enhanced in SAS Human Capital Management 5.2:

- enhanced employee profiles, including multiple profiles, profile templates, external actions, and search capabilities
- enhanced geographic analysis, with better performance and filtering support
- built-in content management, including the ability to manage permissions and register for alerts
- tighter integration with SAS BI Dashboard, including a new provider for SAS Human Capital Management metrics
- built-in support for single-variable forecasting
- support for workforce planning and budgeting (with SAS Financial Management)
- support for retention analysis using predictive analytics
- an enhanced Administration application, including the following new or enhanced features:
  - consolidated security administration (object-level security, row-level security, and column-level security)
  - employee profile management: the ability to create and assign custom profiles
  - the ability to create cubes and information maps
  - the ability to create and manage measures
  - configuration management
  - a public API for customizing profile and Home page templates
• a diagnostic tool for SAS Human Capital Management, with these features:
  • reports on critical configuration elements, SAS server connections, database
    connections, and applications that are running on the managed servers
  • accessibility from the Administration application or from the command line

Changes to Stored Processes

The following features have changed in SAS Human Capital Management:

• Stored processes cannot be executed within a Microsoft Office application. They can
  be executed from the workspace, from a shortcut link, from SAS Web Report Studio,
  or from the action menu in the Employee Browser or a geographic analysis.
Introduction

SAS Human Capital Management includes the following accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended.

If you have questions or concerns about the accessibility of SAS products, send an e-mail message to accessibility@sas.com

Keyboard Navigation

Standard Keyboard Navigation

SAS Human Capital Management can be navigated by using the keyboard. The following table includes some guidelines:

<table>
<thead>
<tr>
<th>Task</th>
<th>Keyboard Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move forward through controls</td>
<td>TAB</td>
</tr>
<tr>
<td>Move backward through controls</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Display the contents of a drop-down list</td>
<td>ALT+down arrow</td>
</tr>
<tr>
<td>Display a menu that has focus</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Activate a button or menu selection when it has focus</td>
<td>ENTER</td>
</tr>
<tr>
<td>Open a context menu</td>
<td>SHIFT+F1</td>
</tr>
</tbody>
</table>

Shortcut Keys Added for Faster Navigation

SAS Human Capital Management enables the following keyboard shortcuts for faster navigation for some wizards, such as the New Cube wizard:
### Task

<table>
<thead>
<tr>
<th>Task</th>
<th>Keyboard Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Next</td>
<td>ALT+right arrow</td>
</tr>
<tr>
<td>Select Previous</td>
<td>ALT+left arrow</td>
</tr>
<tr>
<td>Select Finish</td>
<td>ALT+up arrow</td>
</tr>
<tr>
<td>Select Cancel</td>
<td>ALT+down arrow</td>
</tr>
</tbody>
</table>

---

### Using SAS Human Capital Management 5.2 with JAWS

#### Tables Used for Screen Layout

When tables are used for screen layout in some dialog boxes, JAWS reads the table dimensional information. To ensure that all fields are read, set your JAWS reader to read one row at a time and use the standard JAWS keystrokes for reading a table.

#### The Edit Field

When using the keyboard to navigate to the Edit field, JAWS repeats the last valid item that it was able to read before a header or a footer.

---

### High Contrast and Custom Color Styles

There is intermittent support for high contrast and custom color styles in SAS Human Capital Management.
Chapter 1
Getting Started with SAS Human Capital Management

What Is SAS Human Capital Management?

SAS Human Capital Management software integrates workforce data into a single source of information, enabling you to analyze your workforce, measure performance, and produce reports based on regulatory or organizational needs.

In a Web browser, as an end user, you can log on to SAS Human Capital Management and perform these tasks:

• browse, search, print, and export employee information
• search employee information and graph the search results
• create and customize an organization analysis
• create and customize a geographic analysis
• create and view Web reports that are based on information maps
• run stored process reports, including forecasting reports
• perform multidimensional analysis of OLAP cubes
• create and view dashboards, key performance indicator (KPI) projects, or (with SAS Strategy Management installed) scorecards, using predefined or custom workforce metrics

Administrators can also perform a number of management, administration, and configuration tasks, as described in the SAS Human Capital Management: Administrator's Guide.
Using SAS Human Capital Management provides the following benefits:

- **You can analyze the workforce and simulate organizational changes.** Predefined analytics such as organization analysis display organizational hierarchies in a list of graphical views while surfacing critical data about the workforce. You can also simulate organizational structure changes for workforce planning and modeling by moving groups or people to see the effect.

- **You can measure and improve workforce productivity.** For the analysis of key indicators, SAS Human Capital Management provides an extensive set of prepackaged metrics as well as the ability for users to create their own measures. Combined with the SAS BI Dashboard (part of the SAS Intelligence Platform), SAS Human Capital Management enables you to view the status of key metrics, such as revenue per employee, relative to goals.

- **You can minimize risk by changing likely outcomes.** SAS Human Capital Management provides advanced analytics and easy-to-use interfaces so business users can identify and minimize risks by predicting workforce changes and analyzing associated costs. Forecasting or analytic expertise is not needed.

- **You can budget for future workforce needs.** When integrated with SAS Financial Management, SAS Human Capital Management makes detailed employee information available for planning and budgeting within a structured workflow.

---

**Log On to SAS Human Capital Management**

Your administrator will provide the URL to the logon page for SAS Human Capital Management. Type your user name and password on the logon page and click Log On. The password is case sensitive.

Logging on to SAS Human Capital Management requires membership in specific groups and roles. If your logon fails, contact your administrator.

**CAUTION:**

Be sure to log on to SAS Human Capital Management in a separate browser window. Tabbed browsing (available with Microsoft Internet Explorer 7) is not supported in the portal or in SAS Human Capital Management. After you log off, close the browser window. If you are using Internet Explorer 8 with SAS Human Capital Management you need to select compatibility mode. You can enable compatibility mode in Internet Explorer 8 by selecting **Tools ➤ Compatibility View** in your Internet Explorer browser.

---

**About the Home Page**

When you log on to SAS Human Capital Management, you are taken to the Home page. Its contents vary, depending on your permissions and on site configuration. Here is an example:
The Tasks list contains links to available tasks, such as opening the Employee Browser or creating a geographic analysis.

2 The Manage list contains links to management tasks, such as managing the workspace.

3 The Shortcuts section contains shortcut links that you define.

4 The Search text box and button support the general search utility.

5 If the Home page has been configured to display dashboards, the BI Dashboard portlet displays the currently selected dashboard. If multiple dashboards have been defined, you can select from a drop-down list at the bottom of the page.

   Note: The Home page might be configured to display other information, or this section of the Home page might be empty.

6 Click Log Off to log off SAS Human Capital Management.

7 Click Preferences to open a dialog box for selecting preferences such as language and theme.

8 From the Help menu, select Help Contents to display the online Help, beginning with an overview of SAS Human Capital Management. Select Help on this page to display help for the current page. Select About for general information about SAS Human Capital Management.

These links are available on most pages:

• The logo in the upper right corner (such as sas) is a link to the Home page.

• The Back button is a link to the last page you visited.

The Tasks List

The Tasks list contains links to the tasks that you have permission to perform. Possible links include the following:
• **My Employee Profile.** Open the Employee Browser, in which you can view a summary of information about a group of employees or view detailed information about a single employee. See Chapter 4, “The Employee Browser,” on page 35.

• **New Organization Analysis.** Create an organization analysis, in which you can view the structure of an organization in a hierarchical table or a graphical organization chart. You can also simulate a reorganization. See Chapter 5, “Organization Analysis,” on page 49.

• **New Geographic Analysis.** Create a geographic analysis, with which you can analyze workforce data by geographic region. Map view displays the data over a map; you can drill down to more detailed maps and the associated data. Table view displays information in a table. See Chapter 6, “Geographic Analysis,” on page 63.

• **New Report.** Create a report in SAS Web Report Studio. The input data can be an information map or the results of executing a stored process. See Chapter 10, “Creating Reports with SAS Web Report Studio,” on page 97.

• **New HR Scorecard.** Create a scorecard in the KPI Viewer or in SAS Strategy Management, depending on your installation. See Chapter 12, “Metrics and Scorecards,” on page 109.

• **My Portal.** Open your portal page in the browser. On this page you can see other portal content, as well as the SAS HCM Content portlet, a collection portlet that contains a shortcut to the SAS Human Capital Management Home page, as well as any shortcuts that you add. See “The SAS HCM Content Portlet” on page 5.

For more information about collection portlets, see the online Help for the portal.

---

**The Manage List**

The **Manage** section of the Home page contains links to management tasks that you have permission to perform:

• **Workspace.** Manage the folders and files that you have permission to view. See Chapter 3, “The Workspace,” on page 25.

In the workspace, you can find a set of standard reports (SAS reports and stored processes) that are available with SAS Human Capital Management. See Chapter 7, “Viewing the Standard Reports,” on page 75.

You can also find a set of forecasting reports, if they have been configured by your administrator. See Chapter 8, “Forecasting in SAS Human Capital Management,” on page 85.

• **Manage Dashboards.** Create and manage dashboards for viewing key metrics within your organization. See Chapter 9, “Displaying Key Metrics with SAS BI Dashboard,” on page 91.

• **Administration.** For administrators only, this application is used to manage data, security, employee profiles, and similar components of SAS Human Capital Management.
The Shortcuts List

The Shortcuts section of the Home page contains links to documents and folders that you have permission to view. Initially, this section is empty. In the workspace, you can create shortcuts that are useful to you, such as a link to your personal folder or a link to the standard reports.

The General Search Utility

At the top of the Home page is the general search utility, with which you can conduct a search of employees. The text box provides a quick and simple search. The Advanced Search dialog box can be used to build a query. See “Performing a General Search” on page 7.

The SAS HCM Content Portlet

The main page of the portal contains the SAS HCM Content portlet, which is a special collection portlet that by default has a link to SAS Human Capital Management. As a collection portlet, it can contain additional links that you create in the workspace. The following figure shows a SAS HCM Content portlet with two links: one to the Home page of SAS Human Capital Management and one to a stored process.

If you need to add the SAS HCM Content portlet to your portal, follow these steps:

2. In the portal, select Customize ⇒ Edit Page ⇒ Edit Page Content.
3. On the Edit Page Content page, select Add Portlets.
4. For the Portlet type, select SAS HCM Content.
5. Name the portlet.
6. (Optional) Add a description and keywords.
7. Click Add.
8. Click Done.
9. If your portal page uses a column layout, select the column in which your portlet should appear. If your portal page uses a grid layout, add the portlet to the grid.
   For details about the layout of portlets on a page, consult the online Help for the portal.
10. Click OK.

---

**User Customizations**

You can customize your experience with SAS Human Capital Management in several ways, depending on your permissions:

- **Create shortcuts on your Home page.** See “Create a Shortcut” on page 30.
- **Add items to the HCM Content portlet.** See “Add Content to the SAS HCM Content Portlet” on page 29.
- **Customize the Employee Browser, an organization analysis, or a geographic analysis.** For example, you might add tables to the Employee Browser or add measures to an organization analysis or geographic analysis. For details, see the descriptions of those applications.
- **Set user preferences.** Click Preferences at the top of the Home page and set the following preferences:
  - **your language preference.** Most menus, links, titles, and labels are displayed using the language you select, if it is supported.
  - **a theme.** Themes control the look and feel of the display. They include display options such as fonts and images. If more than one theme has been defined at your site, you can select from the available themes.
  - **portal options.** These options control the navigation order (vertical or horizontal) and similar display elements.
  - **scorecard options.** These options affect the display of scorecards, such as the number of rows to display on a page.

**Note:** Date and currency format preferences and alert notification preferences that are set on the portal’s Preferences page do not apply to SAS Human Capital Management. Your HCM administrator sets the date and currency formats, which might reflect the current locale. (No currency conversion takes place.) You specify an alert notification preference when you create an alert in the workspace.

If you encounter any problems displaying a double-byte character set (DBCS), upgrade your browser to Windows Internet Explorer 7 or later.

Administrators can make further customizations, as described in the *SAS Human Capital Management: Administrator's Guide.*
Performing a General Search

About the General Search

The general search is available on the home page of SAS Human Capital Management. The general search performs a query on the default search table, as designated by the administrator.

You can perform the following tasks:

• perform a simple search, by typing a search string in the Search text box
• use the Advanced Search dialog box to construct a complex query
• display the results in a table, a graph, or a map
• export the results table to a Microsoft Excel file
• export the table and graph to a PDF file
• print the results
• e-mail selected employees

If security has been applied to the search table, that security affects both the query and the results. That is, you can search only on columns for which you have permission, and the search results contain only data that you have permission to view.
Simple Search

Perform a Simple Search

The text box next to the Search button is available for simple searches.

```
Search: annual_salary>40000
```

For complex searches, you will probably want to use the Advanced Search dialog box to build your query string.

To perform a simple search:

1. Type a search string into the text box. For example, the following string searches for employees that have an annual salary that is greater than $40,000.
   
   annual_salary>40000

   You can also combine search parameters. For example, the following string searches for active employees who live in Raleigh or Durham.

   `(city_nm=Raleigh OR city_nm=Durham) AND employee_status_cd=A`

   Do not use quotation marks for character strings.

   If search assist is enabled, when you begin to type, a pop-up list displays matching columns for you to select from. For more information, see “Enable Search Assist” on page 9.

2. Click Search.

Note: If your search string contains a reference to a restricted column or a nonexistent column (for example, if you misspell the column name), a warning message is displayed and that search term is ignored.

Search on Default Columns

If your administrator has designated certain columns as default search columns, you do not need to specify those column names. For example, if EMPLOYEE_NAME is a default search column, you can simply type a name to return a list of all matching employees. Partial names are acceptable.

If ANNUAL_SALARY is a default column, the following search string returns a list of all employees with salaries greater than $40,000.

```
>40000
```

Note: Consult your administrator for the names of the default search columns. If no other columns have been configured as defaults, then the EMPLOYEE_NAME column acts as a default search column.

Use Search History

To reuse a previous search string, click the Search History button and select a string from the pop-up list.
Enable Search Assist

Search assist applies to simple searches on the Home page. If search assist is enabled, when you begin typing in the search text box, a pop-up list of matching search fields appears. The search assist box matches column names, symbols, and column descriptions. (If a column has a symbol, which makes queries shorter, the symbol appears instead of the column name.) Select an entry from the list to include the symbol in your query.

For example, if you selected Employee Name from the list, the matching symbol (in this case, EM) would appear in the simple search text box. If a symbol has not been generated for a particular column, the column name appears instead.

Search assist is not available to all users. If you have permission to use search assist, you can enable it by pressing the F12 key or by following these steps:

1. Click Advanced Search.
2. Click the Options tab.
3. Select Turn on Search Assist.

Note: You can also type these column symbols directly into the text box, rather than using the search assist mechanism.

Advanced Search

Perform an Advanced Search

In an advanced search, you can build a search string from available columns and operators:

1. Click Advanced Search.
2. In the Advanced Search dialog box, select and type the appropriate columns, operators, values, and parentheses to build a search string.
3. Click **Add Row** to add a row to the dialog box (to a maximum of 5 rows).

4. To reset the contents of a row, click the **Reset** button.

5. To reset all the rows, click **Clear All**.

6. Click **Submit**.

**Use the Query Tab**

The **Query** tab of the Advanced Search dialog box displays the full search string, which you can edit before clicking **Submit**. However, no validation takes place when you submit your query from this tab. It behaves just like a simple search.

---

### Enable Case-Sensitive Searches

Case-sensitive searches are available only in the Advanced Search dialog box. Simple searches are always case insensitive.

To enable case-sensitive searches:

1. Click **Advanced Search**.

2. In the Advanced Search dialog box, click the **Options** tab and select **Match case**, or press the F11 key.
General Search Functionality

Summary of General Search Options
Here are the options that are available in a general search. Some options depend on whether you are doing a simple search or an advanced search:

Table 2.1 General Search Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to search for active or inactive employees</td>
<td>Yes, both active and inactive employees are included (use search terms to filter results)</td>
</tr>
<tr>
<td>Parentheses permitted around terms</td>
<td>Yes</td>
</tr>
<tr>
<td>Logical operators (AND, OR) permitted</td>
<td>Yes</td>
</tr>
<tr>
<td>Comparison operators (=, !=, &lt;, &lt;=, &gt;, &gt;=) permitted</td>
<td>Numeric, date, and currency fields: yes</td>
</tr>
<tr>
<td></td>
<td>Character fields: = operator only</td>
</tr>
<tr>
<td>Wildcard searches permitted:</td>
<td>Unformatted character fields: yes</td>
</tr>
<tr>
<td>_ matches exactly one letter;</td>
<td>Formatted character fields: yes, if you specify the formatted value; no, if you specify the code</td>
</tr>
<tr>
<td>% matches zero or more letters</td>
<td>All other fields: no</td>
</tr>
<tr>
<td>Case-sensitive searches permitted</td>
<td>Simple search: no</td>
</tr>
<tr>
<td></td>
<td>Advanced search: yes</td>
</tr>
<tr>
<td>Search assist available</td>
<td>Simple search: yes (Home page only)</td>
</tr>
<tr>
<td></td>
<td>Advanced search: no</td>
</tr>
</tbody>
</table>

Date Fields
When searching dates, use the format YYYY-MM-DD (year-month-day), YYYY-MM (year-month), or YYYY (year).

Currency Fields
When a numeric field represents a currency, the search string can include or omit currency symbols (such as the dollar sign) and separators (such as a comma or decimal point). The result is the same either way.

Formatted Character Fields
In some cases, the format in which data is displayed is different from the format in which it is stored. For example, Job Group data might be stored as an alphanumeric code such as 1H, but displayed as Manager High; or it might be stored as 3T but displayed as Technical.

When a character field is formatted, you can search by the code or by the display format. If you search by code, you must specify the entire code. Wildcards do not apply.
**Wildcards**

You can use wildcards in formatted or unformatted character fields. Two types of wildcards are permitted:

- `_` (underscore): matches exactly one letter.
- `%`: matches zero or more letters.

If the search string does not explicitly include a wildcard, then the search mechanism adds `%` to the beginning and end of the string (for unformatted fields) or to the end of the string (for formatted fields).

Here are some examples of search strings for employee name (an unformatted field). Because employee name is always a default search column, you can omit the column name.

<table>
<thead>
<tr>
<th>Search string</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>will</td>
<td>Finds all employees with a name that includes the string “will”, such as Williams, Ted or Rogers, Will or Terwilliger, Frank. Because there are no wildcards in the input string, the search utility adds a percent sign (%) to the beginning and end of the string.</td>
</tr>
<tr>
<td>b%</td>
<td>Finds all employees whose last name begins with a “b”, such as Brady or Banks. Because there is a wildcard at the end of the search string, the search utility does not add a wildcard.</td>
</tr>
<tr>
<td>%ay%</td>
<td>Finds all employees whose name contains “ay”, such as Gray or Zaytoun. Searching for ay (without wildcards) returns the same results. If the search argument contains no wildcards, % is automatically added to the beginning and end of the search string.</td>
</tr>
<tr>
<td>%, B%</td>
<td>Finds all employees whose first name begins with “B”. (In the sample data, a comma separates the last name from the first name.) The case is disregarded unless this is a case-sensitive search.</td>
</tr>
<tr>
<td>berr_,%</td>
<td>Finds all employees with a last name that begins with “berr” and is five characters long.</td>
</tr>
<tr>
<td>_b%</td>
<td>Finds all employees whose last name contains a “b” as the second character.</td>
</tr>
</tbody>
</table>

Here are some examples of searches that include a formatted character field. Either the code or the formatted display value is acceptable. However, wildcards work only with the formatted string.

In the first example, you want to find all employees with a job group that begins with the word “manager”, such as Manager High or Manager Low. The search string looks like this:

\[ \text{JG}=\text{manager} \]

(Assume that JOB_GROUP_CD has a search symbol of JG.) Because Job Group is a formatted field, the search utility adds a wildcard only to the end of the string. (A search string of JG=high or JG=low would return no results.)

The search results look like this:
In the next example, assume that you are searching for an employee named Jones who lives in either North or South Carolina. (Assume that the STATE_REGION_CD column has a search symbol of **SRR**.) You could enter this search string, which uses the unformatted state codes:

```sql
jones and (srr=NC or srr=SC)
```

You could also apply a wildcard to the beginning of the formatted state name:

```sql
jones and srr=%carolina
```

Because employee name is always a default search column, you can omit the column name. The results might include these rows, showing employees in both states:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Employee ID</th>
<th>Annual Salary</th>
<th>Age</th>
<th>Job Group</th>
<th>State or Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones, Brian T.</td>
<td>10035</td>
<td>$54,983.55</td>
<td>47</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Jones, James F.</td>
<td>10203</td>
<td>$55,360.97</td>
<td>49</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Yim, Su-Jim R.</td>
<td>10287</td>
<td>$49,362.04</td>
<td>38</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Page, Russell S.</td>
<td>10314</td>
<td>$45,131.01</td>
<td>54</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Woodcock, Stephanie F.</td>
<td>10327</td>
<td>$46,092.46</td>
<td>35</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Marshall, Ann Patricia</td>
<td>10433</td>
<td>$228,209.21</td>
<td>55</td>
<td>Manager High</td>
<td></td>
</tr>
<tr>
<td>Brown, John I.</td>
<td>10510</td>
<td>$45,945.43</td>
<td>41</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Gallelli, John R.</td>
<td>10537</td>
<td>$58,618.66</td>
<td>38</td>
<td>Manager Low</td>
<td></td>
</tr>
<tr>
<td>Johnson, Robert N.</td>
<td>10644</td>
<td>$142,191.96</td>
<td>43</td>
<td>Manager High</td>
<td></td>
</tr>
<tr>
<td>Richardson, Henry J.</td>
<td>10676</td>
<td>$563,131.43</td>
<td>57</td>
<td>Manager Low</td>
<td></td>
</tr>
</tbody>
</table>

In this third example, imagine that you want to find an employee named Smith who works in sales. You happen to know the Job Group code, so you enter this search string using the unformatted value:

```sql
smith and jg=2s
```

Remember that wildcards do not apply to unformatted values; you must specify the entire code. The search results look like this:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Employee ID</th>
<th>Annual Salary</th>
<th>Age</th>
<th>Job Group</th>
<th>State or Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones, Norella C.</td>
<td>17584</td>
<td>$43,391.14</td>
<td>34</td>
<td>R&amp;D High</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Bud S.</td>
<td>19541</td>
<td>$37,341.64</td>
<td>50</td>
<td>R&amp;D Low</td>
<td>South Carolina</td>
</tr>
<tr>
<td>Jones, Maurice H.</td>
<td>19554</td>
<td>$37,179.62</td>
<td>37</td>
<td>Technical</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Susan R.</td>
<td>5389</td>
<td>$81,978.73</td>
<td>44</td>
<td>Administrative Professional</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, David E.</td>
<td>6929</td>
<td>$45,534.56</td>
<td>43</td>
<td>Technical</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Harper T.</td>
<td>8372</td>
<td>$54,072.63</td>
<td>36</td>
<td>Administrative Professional</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Wendy M.</td>
<td>8459</td>
<td>$76,053.20</td>
<td>49</td>
<td>Technical</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Cynthia R.</td>
<td>8714</td>
<td>$44,376.18</td>
<td>63</td>
<td>R&amp;D High</td>
<td>North Carolina</td>
</tr>
<tr>
<td>Jones, Willard R.</td>
<td>9159</td>
<td>$70,396.60</td>
<td>47</td>
<td>Technical</td>
<td>North Carolina</td>
</tr>
</tbody>
</table>
Comparison Operators
You can use comparison operators in numeric fields, including date and currency fields. For character fields, you can use the equals (\(=\)) operator.

A relational operator can be one of the following:

- \(=\) Equal
- \(!=\) Not equal
- \(>\) Greater than
- \(>=\) Greater than or equal
- \(<\) Less than
- \(<=\) Less than or equal

Working with the Search Results

The search results are displayed in a table. By default, the employee name and employee ID are displayed. To add more columns to the display:

1. Click **Options**.
2. On the Options page, select the columns to be displayed.
   
   Use the right arrows to move columns from the **Available Columns** box to the **Selected Columns** box. Use the left arrows to remove columns from the display. Use the up and down arrows to rearrange the order in which the columns are displayed.

3. (Optional) Set the number of rows to display at a time.
4. Click **OK**.

To add a graph or a map to the page, see “Graphing the Search Results” on page 15. To print the results, click the Print button 📑 on the toolbar.

To export the results to a Microsoft Excel file or a PDF file, select **Save As ⇒ Excel** or **Save As ⇒ PDF File** from the toolbar.

To send an e-mail message to all employees in the search results list, click **Email All** on the toolbar. An e-mail message is created, and the **To** line is populated with the address of each employee in the search results.

*Note:* This feature uses the mailto protocol and is subject to its limitations on both message size and the size of the **To** list. If you receive an error, try restricting your search so that you get fewer results.

---

**Graphing the Search Results**

**About Working with Graphs**

After you perform a search, you can display the search results in a graph as well as in a table. These graphs are easy to create and are designed to be temporary in nature. When you perform a new search or select a different graph, the current graph is replaced. However, you can save both the table and the current graph to a PDF file, using the **Save As** menu in the toolbar. If you then import the PDF file to the workspace, you can add it to a portlet.

*Note:* To remove a graph and display only the table, click the Table Viewer button 📑 in the toolbar.

**Create a Graph**

To graph the results of a general search, follow these instructions. For details about a specific graph type, see “Types of Graphs” on page 19.

1. Perform the search.

2. On the search results page, select a graph type:
   - **Bar Chart**
   - **Pie Chart**
   - **BarLine Chart**
   - **Scatter Plot**
   - **Line Chart**
   - **Geo Map**

   The graph is displayed below the results table, with default attributes.

3. (Optional) Rearrange the display of the results table or the graph by dragging the table or graph to a new position on the page. In this example, the graph and table are side by side, and the table has been moved to the right of the graph.
4. To modify the properties of the graph, select **Graph Options**.

5. In the Graph Options dialog box, select measures for the graph.

   Measures are numerical values such as age or salary. In bar and line graphs, measures are displayed along the vertical axis. Multiple measures are represented by multiple bars, lines, or markers, using the same scale for all measures, based on the largest value.

   a. Select a measure.

   Measures are identified by the Measure icon 📈.

   b. Either drag the measure to its destination (such as **Bar Height**), or use the **Move Items** menu to select a destination. Invalid destinations are dimmed.

Most graphs can display multiple measures, as in this bar chart that shows both the count and the average monthly salary for division employees.
6. Select statistics for the measures. (Does not apply to scatter plots.)

By default, each measure that you select is displayed as a count. To change the statistic (for example, to a sum or an average):

a. Select the measure.

b. From the **Move Items** menu, select a statistic.

7. Select categories for the graph.

A category determines the way the measures are organized (for example, by division, department, geographical area, or gender). A graph can have only one category. Categories are displayed on the horizontal axis or in the legend, depending on the type of graph. In a scatter plot, a category is optional.

a. Select a category. Categories are identified by the Category icon.

b. Select a destination for the category.

8. (Optional) Select a subcategory.
Subcategories represent a subdivision of the category. For example, if the category is Division, the subcategory might be age range (as in the figure that follows), gender, or marital status.

To create a subcategory, move a category to a subcategory list in the Graph Options dialog box. For example, move a category to Bar Subgroup to create a subcategory for a Bar Chart.

Note: Not all graphs contain subcategory fields.

Figure 2.1  Bar Chart Showing the Employees in Each Division, Subdivided by Age Range

9. (Optional) Select a category for a horizontal or vertical series. (Does not apply to maps.)

A series displays a set of graphs, one for each instance of a category. Series can be horizontal or vertical, depending on whether you want the graphs to appear side by side or stacked vertically.

This horizontal series displays employee count by division in two different graphs, one for women and one for men.

Figure 2.2  Bar Chart with Horizontal Series

10. If a property has multiple selections, you can reorder the selections by dragging a column to its new location, or by selecting a column name and then selecting Move Up or Move Down from the Move Items menu.

11. To remove a category or a measure from the display, move it to the Hidden section of the graph options.

12. Click OK.
Types of Graphs

Bar Charts
In SAS Human Capital Management, a bar chart consists of a grid and vertical bars that represent numeric measures. For example, this bar chart shows the number of employees for each department in a (fictitious) company.

Figure 2.3  Bar Chart of Number of Employees

Bar chart properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Height</td>
<td>Measures for this graph. Displayed along the vertical axis.</td>
</tr>
<tr>
<td>Bars</td>
<td>Category in which the measures are organized. Displayed along the horizontal axis.</td>
</tr>
<tr>
<td>Bar Subgroup</td>
<td>(Optional) Subcategory for the graph.</td>
</tr>
<tr>
<td>Horizontal Series</td>
<td>(Optional) Category for a horizontal set of graphs (one per category instance).</td>
</tr>
<tr>
<td>Vertical Series</td>
<td>(Optional) Category for a vertical set of graphs (one per category instance).</td>
</tr>
<tr>
<td>Statistics</td>
<td>Statistics to apply to the measures.</td>
</tr>
</tbody>
</table>

Pie Charts
A pie chart displays information in a circular format, with slices of the pie representing a category (called a segment). The size of each slice represents the relative contribution of that segment to the whole.
Figure 2.4 Pie Charts Showing Employee Count and Annual Salary per Division

Pie chart properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Size</td>
<td>Measures for this graph. Displayed as slices of the pie.</td>
</tr>
<tr>
<td></td>
<td>If you select multiple measures, each measure is displayed in a separate pie chart.</td>
</tr>
<tr>
<td>Segments</td>
<td>Category in which the measures are organized. Displayed in the pie chart legend.</td>
</tr>
<tr>
<td>Pie Stacks</td>
<td>(Optional) Subcategory for the pie chart. Displayed in concentric circles.</td>
</tr>
<tr>
<td>Horizontal Series</td>
<td>(Optional) Category for a horizontal set of pie charts (one per category instance).</td>
</tr>
<tr>
<td>Vertical Series</td>
<td>(Optional) Category for a vertical set of pie charts (one per category instance).</td>
</tr>
<tr>
<td>Statistics</td>
<td>Statistics to apply to the measures.</td>
</tr>
</tbody>
</table>

Bar-Line Charts

A bar-line chart is a bar chart with an overlaid line graph. Notice that the same scale applies to both the bars and the line.

Figure 2.5 Bar-Line Chart Showing Number of Employees and Average Age per Organization Report Group

Bar-line chart properties are as follows:
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bar Height, Line Height</strong></td>
<td>Measures for this graph. Displayed along the vertical axis as vertical bars and a line graph.</td>
</tr>
<tr>
<td>Category</td>
<td>Category in which the measures are organized. Displayed along the horizontal axis.</td>
</tr>
<tr>
<td>Horizontal Series</td>
<td>(Optional) Category for a horizontal set of graphs (one per category instance).</td>
</tr>
<tr>
<td>Vertical Series</td>
<td>(Optional) Category for a vertical set of graphs (one per category instance).</td>
</tr>
<tr>
<td>Statistics</td>
<td>Statistics to apply to the measures.</td>
</tr>
</tbody>
</table>

**Scatter Plots**
A scatter plot displays the relationship between two variables as a collection of points, one plotted along the vertical axis and one plotted along the horizontal axis. In SAS Human Capital Management, each point is represented by a filled circle.

*Figure 2.6* Scatter Plot Showing Relationship between Annual Salary and Age

Scatter plot properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vertical axis, Horizontal Axis</strong></td>
<td>Measures for this graph. Displayed along the vertical and horizontal axes.</td>
</tr>
<tr>
<td>Marker Groups</td>
<td>(Optional) Category for the graph. Displayed in a legend. (Each marker group has a different color.)</td>
</tr>
<tr>
<td>Horizontal Series</td>
<td>(Optional) Category for a horizontal set of graphs (one per category instance).</td>
</tr>
<tr>
<td>Vertical Series</td>
<td>(Optional) Category for a vertical set of graphs (one per category instance).</td>
</tr>
</tbody>
</table>

**Line Chart**
A line chart typically shows the relationship between two variables.
A line chart might compare two different variables in the same category (as in the preceding example), or it might compare values of the same variable as plotted against two different categories. For example, you might compare the effect an employee’s length of service has on salary, depending on the employee’s age.

Line chart properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line Height</strong></td>
<td>Measures for this graph. Displayed along the vertical axis.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Category in which the measures are organized. Displayed along the horizontal axis.</td>
</tr>
<tr>
<td><strong>Multiple Lines</strong></td>
<td>(Optional) Subcategory for the graph.</td>
</tr>
</tbody>
</table>
Geo Maps
To display search results in a geographic map, click the Geo Map button in the toolbar. The map that is displayed is chosen to fit the results, based on the maps that are defined for your site. For example, if all the employees in the search results lived in Ohio, a map of Ohio would be displayed. If the employees lived in multiple states, a map of the United States would be displayed, and if they lived in multiple countries, a map of the world would be displayed. No drill-down is permitted, unlike the maps in a geographic analysis.

As you position the mouse pointer over an area, a data tip lists the statistics for that area.

Figure 2.9  A Geographic Map of the United States Displaying Search Results for an Annual Salary Range

Geo map properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Measures</td>
<td>Measures for this graph. Displayed in the legend and in a data tip.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Statistics to apply to the measures.</td>
</tr>
</tbody>
</table>
Chapter 3

The Workspace

About the Workspace

Workspace Tasks ................................................................. 25
How Folders Are Organized .................................................. 26

Managing Content in the Workspace ....................................... 27
Import Content ................................................................. 27
Refresh the Workspace ....................................................... 27
Search Content .................................................................. 27
Move Content .................................................................... 29
Add Content to the SAS HCM Content Portlet ....................... 29
Create a Shortcut .............................................................. 30
Share Content Via E-Mail .................................................. 30
Delete Content .................................................................... 30

Setting Document and Folder Properties .................................. 30
About Document and Folder Properties ................................. 30
Set Permissions .................................................................. 31
Add Users & Groups .......................................................... 31

Managing Alerts ................................................................. 32
About Alerts .................................................................... 32
Create an Alert .................................................................. 32
Disable an Alert .................................................................. 33
View Alerts in a Portlet ..................................................... 33

About the Workspace

Workspace Tasks

The workspace displays the folders and files that are available from SAS Human Capital Management. In the workspace, you can perform the following tasks:

- organize content
- move files from one folder to another
- create shortcuts for folders or files in the workspace
- add files to the SAS HCM Content portlet
- rename files or folders
- delete files or folders
• search for content
• set permissions on content
• share content
• enable alert notifications to be sent for content changes

The actions you can perform depend on file and folder permissions.

How Folders Are Organized

The folder organization in the workspace reflects the organization in the metadata repository—a collection of information (metadata) about the data that makes up your SAS installation. Your permissions determine the folders that you can view and the tasks that you can perform. If you are not able to access a folder that you need, consult with your HCM administrator.

The top level of folders (SAS Folders) looks like this:

The following is a sample of folders you can find in the workspace and their location:

• **My Folder**: your personal folder, in which you typically store content that you create or import.

• **Products ⇒ SAS Human Capital Management**:
  • **5.2 Jobs**: SAS Data Integration Studio jobs
  • **Reports**: the standard stored processes and SAS Web Report Studio reports
  • **Data Sources**:
    • **Cubes**: generated cubes as well as jobs to build cubes
    • **Information Maps**: location for information maps
  • **Shared Data**: content that is shared with other users (depending on permission settings)
  • **System**: files that are used by the installed applications
  • **Users**: a subfolder for each user (Users ⇒ your-login-name ⇒ My Folder is the same as My Folder)

Some of these folder locations are configurable by the HCM administrator. Your administrator might create additional custom folders for shared content at your site.

By default, the workspace sorts items by name in ascending order, with folders first and documents second. To reverse the sort order, or select a different column to sort on, click the column heading.
Managing Content in the Workspace

Import Content

To import content:

1. Click the Import Content toolbar button.
2. In the Import Content dialog box, click Browse to select a file.
3. Enter a name for the imported file. The name can have a maximum of 60 characters.
4. (Optional) Enter a description for the imported file. This description is displayed if the user selects the Show description check box in the workspace, and it can be searched.
5. Select a destination for the file and click OK.

Refresh the Workspace

While you are in a session, other users might be making changes to the workspace content (for example, adding or deleting documents). To reflect these changes, click the Refresh Workspace toolbar button.

Search Content

To search for content:

1. Open the Search pane by clicking the Expand button at the top of the workspace.
2. Enter your search criteria. Do not use quotation marks. Searches are not case-sensitive.

Search for
Enter a search string (all or part of a filename, description, or key word). Searches are case-insensitive. An asterisk (*) can be used to match zero or more characters, as follows:

• Add an asterisk to the end of the search string. For example, a search string of geo* would match files with names such as Geo_01, geo_02, or geoTest.

• Add an asterisk to the beginning and end of the search string. For example, a search string of *eo* would match the preceding files, as well as files with names such as MyGeoAnalysis.

• If you omit all wildcards in your search string, an asterisk is added to the beginning and end of the search string. If you include a wildcard in your search string, no additional wildcards are added.

• A wildcard within a search string (for example, My*Analysis) is not permitted.

Search what
Select Name, Description, or Keywords.

Search where
Select a folder for the start of the search.

Search subfolders
Select this check box if you want to drill down below the starting folder.

Date/time limits
To restrict your search to a specific time period, select Search for Files Modified. Then specify a time period for the search.

3. Click Search.

All matching documents are displayed in the Search Results folder. The action menu is available, just as it is for documents in the folder structure.

To return to a previous folder, select from the Location drop-down list.
Move Content

To move a document or folder in the workspace:

1. From the action menu at the left of the item, select Move.
2. In the Move dialog box, select a destination and click OK.

Add Content to the SAS HCM Content Portlet

By default, the SAS HCM Content portlet contains a link to the SAS Human Capital Management Home page. You can add shortcuts to additional content, as follows:

1. Click the action menu to the left of the item and select Add To Portlet.
2. On the Add to Portlet dialog box, select the Show Description check box to display the item's description (if there is one) in the portlet.
3. Select the Show Location check box to display the item's location in the portlet.
4. Click OK.

For more information about the SAS HCM Content portlet, see “The SAS HCM Content Portlet” on page 5.
Create a Shortcut

To create a shortcut (link) to a document or folder, click the action menu to the left of the item and select Create as shortcut. A link is added to the Shortcuts section of your Home page.

Share Content Via E-Mail

To send an e-mail message that contains a link to a document, click the action menu to the left of the item and select Email Link. An e-mail message is opened in Compose mode, containing a link to the item.

Delete Content

To delete a document or folder, click the action menu to the left of the item and select Delete.

Setting Document and Folder Properties

About Document and Folder Properties

To open the properties for a document or folder, click the action menu to the left of the item and select Properties.

The top section of the Properties dialog box contains general properties about the item, such as its name and location. If you have the appropriate permission, you can modify the name or the description.

Note: You cannot rename an employee profile document.

The Permissions section of the dialog box contains information about permissions for the item.
Permissions have the following meaning:

- **Read Metadata**: View an item.
- **Write Metadata**: Change or delete an item, or update its permissions.

For example, if you created a report that you wanted to make available to other users, you might move the report to a shared folder, making sure that those users or groups had **Read Metadata** permission for the report and for the folder containing the report. If you wanted those users to be able to update the report, then you would also grant them **Write Metadata** permission.

### Set Permissions

To set permissions for a document or folder in the workspace:

1. For the appropriate user or group, click the box under the permission. There are four possible states:

<table>
<thead>
<tr>
<th></th>
<th>Direct grant: the user or group is directly granted the permission.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![checkmark]</td>
<td>Direct denial: the user or group is directly denied the permission.</td>
</tr>
<tr>
<td>![checkmark]</td>
<td>Inherited grant: the user or group inherits the permission from its containing folder.</td>
</tr>
<tr>
<td>![checkmark]</td>
<td>Inherited denial: the user or group is denied permission, based on permissions that were assigned to the containing folder.</td>
</tr>
</tbody>
</table>

2. To restore an inherited permission, click outside the box.
3. To add an identity (user or group) to the list, click **Add Users & Groups**. (See “Add Users & Groups” on page 31.)
4. To remove a user or group from the set of permissions, click the action menu ![remove] at the left of the identity and select **Remove**.

   *Note*: You cannot remove folder permissions for a user or group if those permissions are inherited by a document in that folder.

### Add Users & Groups

When you are setting permissions for a document or folder in the workspace, click **Add Users & Groups** to add one or more identities to the list. In the dialog box that appears, follow these steps:
1. In the Search box, enter a search string.
   The search string is not case sensitive. You can enter the name of an identity (such as sasdemo) or its display name (such as SAS Demo User), or a partial search string (such as demo). Do not use quotation marks.
   To search for all identities within the specified scope, leave the search string empty.
2. Limit the scope of the search by selecting one or more identity types (such as Users).
3. Click Search.
   The search results display all matching identities.

4. Select one or more identities.
5. Click Add to add the identity and search for other identities. Click Add & Close to add the identity and return to the file properties.

---

Managing Alerts

About Alerts

An alert is an automatic notification of an electronic event that might be of interest to you. In the workspace, you can request to be notified when one or more of these events occur:

- a document's properties are changed, or the document itself is updated
- a document is moved
- a document is deleted

Note: Workspace alerts apply only to events that occur in the workspace. For example, if someone deletes a document in SAS Management Console, the workspace is not aware of that event.

Create an Alert

To add an alert to a document in the workspace, follow these steps:

1. In the workspace, click the document name and select Alerts from the action menu.
2. In the Workspace Alerts dialog box, make the following entries:
   
   Notify when
   Select one or more events to trigger the alert:
- **Workspace item updated**: Trigger the alert when the item or its properties are changed.
- **Workspace item moved**: Trigger the alert when the item is moved to another folder.
- **Workspace item deleted**: Trigger the alert when the item is deleted.

**Alert name**
Enter a name to identify the alert. This name appears in the subject line of an e-mail alert, or in the link of an alert in the portal. The default is the item's name.

**Delivery method**
Select a method for delivering the alert:
- **Display in portal**: Display the alert in an Alerts portlet.
- **Email**: Deliver the alert in an e-mail message.
- **Email and display in portal**: Display the alert in an Alerts portlet and send an e-mail notification.

3. Select **This alert is active**.
4. Click **OK**.

If the document is updated or moved, the alert notification contains a link to the document.

---

**Disable an Alert**

To disable an alert, open the alert properties and clear the **This alert is active** box.

---

**View Alerts in a Portlet**

Alert notifications can be sent in an e-mail message, they can be displayed in the portal, or you can select both mechanisms. To view alert notifications in the portal, you must add an Alerts portlet to your portal page. Follow these steps:

1. On the Home page, click **My Portal**.
2. In the portal, select **Customize**  
   **Edit Page**  
   **Edit Page Content**.
3. On the Edit Page Content page, select **Add Portlets**.
4. For the **Portlet type**, select **Alerts**.

![Add Portlets to Page](image)

5. Name the portlet.
6. (Optional) Add a description and keywords.
7. Click **Add**.

8. Click **Done**.

9. If your portal page uses a column layout, select the column in which your portlet should appear. If your portal page uses a grid layout, add the portlet to the grid.

   For details about the layout of portlets on a page, consult the online Help for the portal.

10. Click **OK**.
Chapter 4
The Employee Browser

About the Employee Browser

A Quick Tour of the Employee Browser

In the Employee Browser, you can view a summary of information about a group of employees or view detailed information about a single employee. You can search for employees and print or export employee records or lists of employees.

To open the Employee Browser, click My Employee Profile on the Home page. The following figure shows the Employee Browser in Browse mode.
Click **Back** to return to the Human Capital Management home page if on the Browse tab. Click **Back** to return to the Browse tab if on the Search tab.

2. At the top of the page is the description of the selected profile (in this case, **Employee Profile Document Metadata**) and the selected hierarchy (**Internal Org for HR**).

3. On the **Browse** tab, you can browse a hierarchy of employee data.

4. On the **Search** tab, you can search for employees using one or more criteria.

5. Click **Print** to print the table from the current page.

6. Use the **Hierarchy** menu to change the current hierarchy.

7. Open the **Save As** menu to export an employee summary as a Microsoft Excel workbook or a PDF file, or to export an employee record as a PDF file.

8. Click **Workspace** to manage files in the workspace.

9. Click **Options** to customize an employee profile.

10. Use the **Find People** utility to conduct a quick search for an employee or for a node in the hierarchy. Each time you click **Find**, the search returns the next matching record.

11. Use the navigation tree to make selections from the organizational hierarchy.

12. Click the Hide Left button to hide the navigation tree. To display the tree again, click the Show Left button.

13. The display area displays employee data, such as a summary of employees or information about a single employee.

**Note:** Not all features are available to all users. In addition, the information that is displayed is subject to security, as applied by your administrator.
About the Employee Profile

An employee profile determines the columns and tables that are displayed in the Employee Browser when you view an employee record, view a list of employees in an organizational unit, or conduct an employee search.

Typically, the type of data you need to see depends on your function in the company. For example, if you are a human resources specialist, you might be particularly interested in compensation data. If you are a manager who is planning a reorganization, you might be particularly interested in geographic data. Employee profiles enable you and your administrator to customize the display to suit your needs.

Some users need more than one employee profile. Your administrator can assign you two or more profiles, and you can select a profile to view. Each profile would provide a different view of the employee data.

Using the Employee Browser

Navigate the Hierarchy

To open the Employee Browser, select My Employee Profile from the Tasks menu, as shown in the following display:

If you are not a manager, the Employee Browser opens to your employee record. Otherwise, it displays a summary for the highest node that you have permission to view, using the current employee profile. (For an explanation of employee profiles, see “About the Employee Profile” on page 37.)

In the left pane of the Browse window, you see the navigation tree, with nodes that represent companies, divisions, departments, or managers, based on the currently selected hierarchy.

To browse the employees in an organization:

1. In the navigation tree, click the name of a node (for example, a department name).

   A list of employees in that node appears in the display area. In this example, the Accounting department has been selected:
2. If the list contains more rows that can be displayed at one time, use the up and down arrows to navigate within the display.

*Note:* In the Options dialog box, you can select the columns and the number of rows to display. See “Customizing an Employee Profile” on page 47.

3. Use the plus and minus buttons to expand or collapse nodes in the hierarchy.

4. Use the Hide Left or Show Left buttons to hide or redisplay the navigation tree.

5. Right-click a column header to manipulate data.

   a. Sort columns by ascending or descending order. Select **Remove All Sorting** to undo sorting changes.

   b. Move columns to the left or right in the table.

   c. Export or save table information.
**View Employee Data**

To view information about an employee:

*Note:* The appearance of this page is determined by your HCM administrator. The layout for each profile can be different.

1. Click an employee name.

That employee's record appears in the display area of the Browse window.

The header might contain information such as employee name, status, and manager name. The header might also contain a photo of the employee, if one is available. Your administrator customizes the header.

2. The remaining information, such as job codes, compensation, and demographic information, is divided into categories. This information might be displayed in a box, on a tab, or in some other way, depending on customizations at your site. To display information from a different category, select that category in the display.

Your administrator creates a default set of categories. You can further customize the display by adding tables and information maps to the list. See “Customizing an Employee Profile” on page 47.

*Note:* Some information might not be displayed because security has been applied to it. For example, your administrator might restrict access to salary information.

3. If your administrator has defined any actions for your employee profile, those links are displayed in the **Actions** section of the display area (for example, links to an external Web page, to a stored process, or to a report). Here is an example.

Click a link to perform the action.
Find People

The **Find People** box provides a quick search for an employee or a node in the hierarchy. It is available in the Employee Browser or in an organization analysis.

For example, to conduct a quick search for an employee whose last name is Kirby and whose first name begins with "W":

1. Enter the search string (such as `kirby, w`) in the **Find People** box.

   ![Find People box](image)

   The search string can contain one of the following:
   - the employee ID (in whole or in part).
   - the employee name (in whole or in part). It is not case-sensitive.
   - The name or description of a node, such as a department or manager name (in whole or in part).

2. Click **Find**.

   The first matching employee record is displayed.

   ![Employee record](image)

   If you entered a node name or description, a summary of employees for that node is displayed.

3. To search for the next matching record, click **Find** again.
**Print Employee Data**

In the Employee Browser, you can print an employee summary or data for a single employee. The data is displayed in a separate window as a PDF file, which you can print or save.

To print an employee summary:
1. Select an organization node or perform a search.
2. Click **Print**.

To print data for a single employee:
1. Click an employee link (typically, the employee name).
2. Click **Print**.
3. The Print Employee Profile dialog box prompts you for the information to print.

Make your selection from the radio buttons. You can print information from all categories, or you can select specific categories to include.

**Export Employee Data**

From the **Save As** menu, you can export employee data:

- Data for an individual employee can be exported to a PDF file.
- Employee summary data can be exported to a Microsoft Excel workbook or a PDF file. Only the summary data for the current node is exported. Subnodes are not included.

To export employee data:
1. From the navigation tree, select a node or an employee.
2. From the **Save As** menu, select **Excel** (employee summaries only) or **PDF File**.

*Note:* When you export a file to Microsoft Excel, you might get a warning message that the file is in a different format than the one that is specified by the file extension. The message appears because the content is an XML stream rather than native Excel format.
Click Yes to open the file. In Microsoft Excel, when you save the file, save it in Excel Workbook format.

**Change the Hierarchy**

A typical hierarchy is a tree structure that shows parent-child relationships within an organization (such as a set of divisions and departments, or a hierarchy of managers). If your administrator has defined more than one hierarchy for use in the Employee Browser, you can select the hierarchy to view.

To change the hierarchy, select from the Hierarchy drop-down menu.

![Hierarchy dropdown menu](image)

The display is refreshed using the new hierarchy selection.

---

**Searching for Employees**

**Search**

In the Search window of the Employee Browser, you can search for employees who match certain criteria. Your administrator specifies the columns on which you can search. However, you can specify the information that is returned by the search. See “Customizing an Employee Profile” on page 47.

To search for matching employees:

1. In the Employee Browser, click the Search tab.
2. On the Search page, enter one or more search terms.
   
   If you enter more than one search term, an implicit AND is assumed between the terms. In this example, you are searching for an employee whose name contains the string "rob" and whose age is greater than 40.

   ![Search input](image)

3. For a case-sensitive search, select Match case.
Note: Match case does not apply if you specify the unformatted code for a formatted field.

4. Click Search.

The results (with names such as Robert S. Daniels and Jennifer A. Wroblews) are displayed in a table.

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Age</th>
<th>Employee ID</th>
<th>Department Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daniels, Robert S.</td>
<td>46</td>
<td>10004</td>
<td>Goddard, Kathryn N.</td>
</tr>
<tr>
<td>Davis, Robert P.</td>
<td>41</td>
<td>10650</td>
<td>Goddard, Kathryn N.</td>
</tr>
<tr>
<td>Roberson, Gregory M.</td>
<td>44</td>
<td>10887</td>
<td>Burgess, Joan M.</td>
</tr>
<tr>
<td>Wroblews, Jennifer A.</td>
<td>47</td>
<td>11766</td>
<td></td>
</tr>
<tr>
<td>Robert, Dudley T.</td>
<td>49</td>
<td>16898</td>
<td>Johnson, Robert N.</td>
</tr>
<tr>
<td>Lee, Robert T.</td>
<td>41</td>
<td>19680</td>
<td>Burgess, Joan M.</td>
</tr>
<tr>
<td>Wroblews, Elizabeth N.</td>
<td>47</td>
<td>3792</td>
<td>Edgar, James M.</td>
</tr>
<tr>
<td>Wroblews, Barbara T.</td>
<td>58</td>
<td>5073</td>
<td>Goddard, Kathryn N.</td>
</tr>
<tr>
<td>Weaver, Robert J.</td>
<td>47</td>
<td>6345</td>
<td>Chang, Anthony C.</td>
</tr>
<tr>
<td>Keene, Robin A.</td>
<td>56</td>
<td>8238</td>
<td>Corl, Ammon B.</td>
</tr>
<tr>
<td>Zimmerman, Robert C.</td>
<td>43</td>
<td>9030</td>
<td>Vader, Ella</td>
</tr>
</tbody>
</table>

Note: If the selected columns for export are too many, you might receive an error using Internet Explorer. This can occur if the selected columns exceed the browser’s URL limit of 2083 characters.

You can select the columns that are displayed in the search results. See “Customizing an Employee Profile” on page 47.

Click Email All to open an e-mail message window with the e-mail addresses of all employees in the search results on the To line.

Note: For a quick search for a single employee, you can also use the Find People function on the Browse tab.

Search Functionality

Summary of Options
The following options are available in a search from the Employee Browser or from a geographic analysis:

<table>
<thead>
<tr>
<th>Option</th>
<th>Employee Browser</th>
<th>Geographic Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to search for active or inactive employees</td>
<td>Active employees only</td>
<td>Depends on the selections made when the geographic analysis was created</td>
</tr>
<tr>
<td>Parentheses permitted around terms</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Employee Browser</td>
<td>Geographic Analysis</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Logical operators (AND, OR) permitted</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Comparison operators (=, ! =, &lt;, &lt;=, &gt;, &gt;=) permitted</td>
<td>Numeric, date, and currency columns: yes Character columns: no</td>
<td>Numeric and currency columns: yes Date columns: = only Character columns: no</td>
</tr>
<tr>
<td>Wildcard searches (_ and %) permitted</td>
<td>Character columns only</td>
<td>Character columns only</td>
</tr>
<tr>
<td>Case-sensitive searches permitted</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Exact match searches permitted</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Searches on formatted values permitted</td>
<td>Formatted character columns only</td>
<td>No</td>
</tr>
</tbody>
</table>

**Wildcards**

You can use wildcards in character columns. Two types of wildcards are permitted:

- _ (underscore) matches exactly one letter.
- % matches zero or more letters.

If the search string includes no wildcards, the following actions occur:

- For unformatted character columns, a wildcard is added to the beginning and end of the string. For example, a string such as “john” would be processed as if it were “%john %” and would match names such as Littlejohn, Thomas and Smith, John.
- For formatted character columns (Employee Browser only), a wildcard is added at the end of the string. For example, an EEO classification string such as “office” would be processed as if it were “office%” and would match values such as Office and Clerical.

For examples of wildcard searches, see “Wildcards” on page 12.

**Relational Operators**

You can use relational operators in numeric columns, including date and currency columns. (In a geographic analysis, only the = operator is permitted for date columns.)

A relational operator can be one of the following:

- = Equal
- != Not equal
- > Greater than
- >= Greater than or equal
- < Less than
- <= Less than or equal
The default operator for any numeric column is equal (\(=\)). For example, this string searches for employees with an annual salary of exactly $40,000 (assuming that the currency is U.S. dollars):

```
Annual Salary
40000
```

To search for employees with an annual salary of $40,000 or greater, you would use a search term like this:

```
Annual Salary
>=40000
```

### Logical Operators

You can use logical operators in all columns. A logical operator can be one of the following: AND, OR (uppercase or lowercase).

To search for employees between the ages of 20 and 30, inclusive, you would enter the following search string:

```
>=20 and <=30
```

In an expression with multiple AND and OR operators without parentheses, the precedence of the operators is from left to right. For example, the following two strings are equivalent:

```
>20 and <30 or >40
```

```
(>20 and <30) or >40
```

In the Employee Browser, you can use parentheses to explicitly set the precedence in an expression. In a geographic analysis, parentheses are not permitted.

### Formatted Character Columns (Employee Browser Only)

In some cases, the format in which data is displayed is different from the format in which it is stored. For example, Job Group data might be stored as a code such as 1H, but displayed as **Manager High**; or it might be stored as 3T but displayed as **Technical**.

In the Employee Browser, when a character column is formatted, you can search by the display format or by the code. If you click the label for a formatted column, a data tip shows examples of the display format to be used in searching. For example, in the following figure, the Job Group column has a data tip. (You must type in the value; you cannot select a value from the data tip.)

```
Job Group
```

```
Manager High
Manager Low
```

**Note:** In a geographic analysis, you must search by the unformatted value.

### Quoted Strings (Employee Browser Only)

In the Employee Browser, for an exact match to a character string, use double quotation marks around the string. For example, the following string searches for an EEO
classification that begins with “Office and”, such as “Office and Clerical” or “Office and Managers”:

"office and"% 

Without the quotation marks, the search utility would interpret and as a logical operator, rather than as part of the string.

Note: With quoted strings, you must explicitly use wildcards. They are not supplied by default.

If you also wanted the search to be case sensitive, you would capitalize “Office” and select Match case at the bottom of the search pane:

**Date Columns**

When searching dates, you can search using the format **YYYY-MM-DD** (year-month-day), **YYYY-MM** (year-month), or **YYYY** (year).

In the Employee Browser, a data tip appears if you click the label for a date column.

Here are some examples of searching by date:

<table>
<thead>
<tr>
<th>Search string</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>Finds dates in which the year is 2008, regardless of the month or day. This is equivalent to a search string of &gt;=2008.</td>
</tr>
<tr>
<td>&gt;2002</td>
<td>(Employee Browser only) Finds dates after 2002 (that is, 2003 and later).</td>
</tr>
</tbody>
</table>

**Currency Columns**

When a numeric column represents a currency, the search string can include or omit currency symbols (such as the dollar sign) or separators (such as a comma or decimal point).
Customizing an Employee Profile

For each employee profile, your administrator designates certain information to be displayed (for example, the columns that are displayed in a list of employees). You cannot change those selections, but you can modify the columns that are displayed. For example:

- You can select the profile to be customized and displayed in the Employee Browser.
- You can add tables or information maps to the categories that are displayed when you view data for a single employee. Only the rows for that employee are displayed.
- You can select the information that is displayed in an employee summary when you click a node or perform a search.
- You can set the maximum number of rows that are displayed in a table.

*Note:* These customizations apply only to your profile. They do not change the profile's default settings.

To customize an employee profile, click **Options**. Make one or more of the following changes:

1. **Select Employee Profile:** From the drop-down list, select a profile for customization and display.

   ![Select Employee Profile](image)

2. **Set columns to display in search results table:** Select the columns that are displayed when you click a node (such as a department or manager name) or when you perform a search. The **Selected columns** list contains a default set of columns that are configured by the administrator. You can update this list by adding or removing columns.

   *Note:* By default, two columns (typically, **Employee Name** and **Employee ID**) are in the list of selected columns. Those columns cannot be removed.

   ![Set columns to display in search results table](image)

   a. To add columns to the display, move one or more columns from the **Available columns** list to the **Selected columns** list.

   b. To change the order in which the columns are displayed, use the up and down arrows next to the **Selected columns** box.

3. **Select Categories:** In an employee profile, certain categories of information (such as **General** and **Compensation**) are preselected by your administrator. You cannot change these fixed categories, but you can customize the display by adding tables or...
information maps. For example, you might add a table that contains employees’ salary history or absence history.

In the Employee Browser, the data is filtered to show only the records for the currently selected employee.

a. To add a table or information map to the display, select it from the **Available categories** list and click the Move to Target arrow ➔.

b. To change the order in which the tables are displayed in the categories list, use the up and down arrows next to the **Selected categories** box.

4. **Set Rows per page:** In the **Number of rows** box, enter the number of rows that can be displayed at one time in a table.

5. Click **OK**.
About Organization Analysis

A Quick Tour of Organization Analysis

In an organization analysis, you can view the structure of an organization in a hierarchical table (analysis view) or a graphic representation (presentation view).

You can perform the following tasks:

- view summarized data for the organization in a hierarchical structure
- display statistics about the employee population
- display metrics such as the number of days positions are open, total bonus amounts, terminations, and compa-ratios in terms of the displayed hierarchy
- simulate organizational changes for workforce planning and modeling, by moving groups or people to see the effect on the displayed statistics

Here is part of an organization analysis that is based on sample data:
Click to print an organization analysis.

2 Click Back to return to the Human Capital Management home page if in the analysis view. Click Back to return to the analysis view if in the presentation view.

3 Click to create a new organization analysis.

4 Click to copy an organization analysis.

5 Use the Save As menu to export an organization analysis.

6 Click to switch to analysis view, which displays the organization analysis in a hierarchical table. This is the default view.

7 Click to switch to presentation view, which displays the analysis in a graphic view.

8 Click Measures to select the statistics that are displayed in the analysis.

9 Click Modify Organization to simulate a reorganization by moving employees and departments to see the effect on the analysis measures.

10 Click Options to modify options for presentation view or associate a scorecard with an analysis.

11 Use the Find People utility to quickly search for an employee by name or employee ID, or for a node such as a department name or manager name.

12 The organization tree displays the selected hierarchy. Click a node or an employee's name to view data in the Employee Browser.

The remaining columns display the measures for each of the hierarchy nodes and the employees under each node.

Note: Not all features are available to all users. In addition, the information that is displayed is subject to security, as applied by the administrator.
Analysis View

To open an organization analysis, select the analysis from the workspace, from a link in an e-mail message, or from the shortcuts on your Home page.

Analysis view displays the organization analysis as a hierarchical table. (See Figure 5.1 on page 50.) In this view, nodes (such as companies, divisions, departments, or managers) are represented by an icon such as . Employees are represented by an icon such as . The rest of the table contains data about the current node or employee. To modify the statistics that are displayed, click .

- Click the plus or minus symbols beside a node to expand or collapse its contents.
- Click a node to open the Employee Browser and display an employee summary for that node.
- If the display includes individual employees, click an employee name to open the Employee Browser and display information for that employee.
- From the toolbar, click the Presentation View button to display the organization analysis in a graphic view.

Note: Icons might look different for your site because they can be configured by the administrator.

Presentation View

The presentation view of an organization analysis displays the organization chart graphically, as shown in the following figure:

Figure 5.2  Presentation view

Click a node (such as a department name) to display the summary for that node in the Employee Browser. If the display includes individual employees, click an employee name to display that employee's profile.
When you are in presentation view, you can change the graphical display. Right-click a node and select one of these options:

**Action Mode**
controls the way the pointer behaves:
- Click **Select** to select a node.
- Click **Pan** to drag the pointer to move around the display.
- Click **Zoom** to drag the pointer up to dynamically increase the magnification, and down to decrease the magnification.

**Zoom**
sets the magnification level.

**Show All Nodes**
expands all nodes that you previously expanded and then collapsed.

**Set Root**
sets the current node as the root for the display. Use this option to display a subset of the organization.

**Back to Last Root**
reverts to the previous root.

**Reset Root**
returns to the base node (root node).

**Find**
displays the Find dialog box. Type an employee name (in full or in part). For a case-sensitive search, select **Match case**.
Select the direction of the search:
- Click **Across then down** to search nodes one row at a time when the layout of the tree is vertical.
- Click **Down then across** to search children of a node before sibling nodes when the layout of the tree is vertical.

**Tree Layout**
contains layout options for the organization chart:
- Click **Horizontal** to expand from left to right so that the highest level of the organization, or the root node, appears on the left side of the page, and the lowest level member nodes appear on the right side of the page.
- Click **Vertical** to expand from top to bottom and left to right so the highest level of the organization, or the root node, appears at the top of the page, and the lowest-level member nodes appear at the bottom of the page.
- Click **Vertical Stacked Leaves** to expand from top to bottom and left to right—except for leaf nodes (employees), which expand from top to bottom.
- Click **List View** to display nodes that have not been expanded below the parent node in a list.
- Click **Full Tree with Lens** to display multiple, expanded branches of the tree structure.
- Click **Sub Tree with Lens** to display a single, expanded branch of the tree structure.
Copy
copies the content in an organization chart presentation view. Copied content can be
pasted in another environment, such as an e-mail message or a Microsoft Office Word
document or Power Point document.

Print
prints the current view.

---

Create an Organization Analysis

To create an organization analysis, select New Organization Analysis from the Tasks
menu on the Home page.

In the New Organization Analysis dialog box, follow these steps:

1. Give the analysis a unique name, which is displayed at the top of the organization
analysis.

2. (Optional) Enter a description, which can be used in searches and displayed in the
workspace. A description can contain alphanumeric characters, spaces, periods,
commas, hyphens, and underscores.

3. Select the hierarchy to view (in this example, the INTORG_HR hierarchy). A hierarchy
is a tree structure that shows relationships within an organization. For example,
employee data might be organized by division and department, or it might be organized
by manager. The administrator defines the available hierarchies.
4. Depending on your hierarchy choice, the **Information table** drop-down list shows matching tables. Select a table such as the Employee Master table.

5. Select the employees to appear in the organization analysis: **Active employees**, **Inactive employees**, or both. If an information table does not contain an employee status column, then these options are dimmed.

6. If you select **View employee nodes in hierarchies**, then employees are listed under the node they belong to (for example, their department or manager).

**Figure 5.3** Organization analysis without employee nodes

<table>
<thead>
<tr>
<th>Internal Org for HR</th>
<th>Headcount</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACME Computers, Inc.</td>
<td>3008</td>
</tr>
<tr>
<td>U.S.</td>
<td>3004</td>
</tr>
<tr>
<td>Administration</td>
<td>546</td>
</tr>
<tr>
<td>Corporate Comm.</td>
<td>60</td>
</tr>
<tr>
<td>Facilities</td>
<td>186</td>
</tr>
<tr>
<td>Human Resources</td>
<td>295</td>
</tr>
<tr>
<td>Case, Justin</td>
<td>1</td>
</tr>
<tr>
<td>Imre, Barbara A.</td>
<td>1</td>
</tr>
<tr>
<td>Hung, Andrew W.</td>
<td>1</td>
</tr>
<tr>
<td>Waters, William D.</td>
<td>1</td>
</tr>
<tr>
<td>Edgar, James M.</td>
<td>1</td>
</tr>
<tr>
<td>Finance</td>
<td>459</td>
</tr>
<tr>
<td>Accounting</td>
<td>210</td>
</tr>
<tr>
<td>Corporate Legal</td>
<td>130</td>
</tr>
<tr>
<td>Payroll</td>
<td>34</td>
</tr>
<tr>
<td>Purchasing</td>
<td>77</td>
</tr>
<tr>
<td>Johnson, Robert N.</td>
<td>1</td>
</tr>
<tr>
<td>Bergasser, Joan H.</td>
<td>1</td>
</tr>
<tr>
<td>Nufk, Rebecca L.</td>
<td>1</td>
</tr>
<tr>
<td>Crosby, Mary R.</td>
<td>1</td>
</tr>
<tr>
<td>Sterling, Faye K.</td>
<td>1</td>
</tr>
<tr>
<td>Crumpler, Alex M.</td>
<td>1</td>
</tr>
<tr>
<td>Taylor, Melissa E.</td>
<td>1</td>
</tr>
<tr>
<td>Williams, Sylvia A.</td>
<td>1</td>
</tr>
</tbody>
</table>

By default, this check box is not selected, and only hierarchy nodes are displayed (for example, departments or managers).

7. Select **View all department nodes** if you want to view the complete hierarchy, including nodes that have no employees. This option is useful if you are simulating a reorganization. Each member of the hierarchy is included in the organization structure, even if the department has no employees, and even if you do not have permission to view the employees in that department.

By default, this check box is not selected, and only departments with employees are included. This option is useful if you simply want to see the departments that you are authorized to view.

8. Click **OK**.

An administrator might have configured measures for the display by default. Typically, you will want to add some measures to the display. See “Select the Statistics to Display” on page 55. You can also select display options, such as the information that appears in a data tip for each employee. See “Select Display Options” on page 55.
Work with an Organization Analysis

Select the Statistics to Display

After you create an organization analysis, you can select statistics to be displayed in a table (analysis view) or a data tip (presentation view).

1. Click **Measures**.

2. On the Edit Measures dialog box, select a measure (from the **Available measures** list) and a statistic (from the **Statistics** drop-down list). Use the right and left arrows to move measures to and from the **Selected measures** list.

   *Note:* The **Statistics** drop-down list does not apply for non-numeric measures.

   ![Edit Measures dialog box](image)

3. To change the order in which these fields appear in the analysis, use the up and down arrows next to the **Selected measures** box.

4. If you do not want your analysis to include headcount numbers, clear the **Include Headcount** check box.

5. Click **OK**. The analysis is re-displayed, including the new measures.

Select Display Options

To modify the display options for an analysis, click **Options**.

At the top of the Options page is general information about the analysis, including name, description, hierarchy, and table.

Modify the following options as needed:
1. **General**: Select whether to include employee data and empty nodes in the analysis. For an explanation of the View employee nodes in hierarchies and View all department nodes options, see “Create an Organization Analysis” on page 53.

   ![General Options](image)

2. **Tree Display**: Select additional information to display in the analysis.

   ![Tree Display Options](image)

   **Select information to display in tree**
   From the drop-down boxes, select one or more columns to display beside each node or employee symbol (in analysis view) or in a data tip (in presentation view).
   - Select **Name** to display the node name (for example, the department code or manager ID) or employee name.
   - Select **Description** to display the node description (for example, department name or manager title) or employee name.
   - Select **Manager Name** to display the name of the manager that is associated with this node. For an employee, display the name of this employee's manager.

   If you select **None** for both entries, the display defaults to **Description**.

   **Select additional information to display in tooltip**
   From the drop-down boxes, select one or more columns for display. This option applies only in analysis view, and only if you select View employee nodes in hierarchies.

   The information is displayed in a data tip when the mouse pointer is over an employee name. If you select **None** for all entries, the employee name is displayed by default.

   In this example, a user is displaying the data-tip information for employee James Edgar.

   ![Data-tip Example](image)

3. To modify the display format of any of these items, click the corresponding check box for **Bold**, **Italic**, or **Parentheses**. The format applies in analysis view only.
4. To display the data-tip information on a single line, select the **Display as one line** radio button. Otherwise, select **Display as multiple lines**.

5. **Scorecard Association**: Associate a scorecard with an organization analysis.

   a. Select **Only show projects based on the same hierarchy as this document** to select only from scorecards that are associated with the same hierarchy that is used in the analysis.

   Some scorecards are not associated with a hierarchy (for example, you might build a scorecard that contains only data that applies to the entire organization). To choose such a scorecard, clear the check box.

   b. From the **Scorecard project** drop-down list, select a project.

---

**Copy an Organization Analysis**

Click the **Copy To** toolbar button 📝 to create a copy of an organization analysis. A copy is useful as a backup or as the basis of a simulated reorganization.

The Copy To dialog box displays or enables you to enter the following information:

**Name**
Type a name for the copy.

**Description**
(Optional) Type a description.

**Hierarchy**
(Read-only) Shows the hierarchy that applies to this organization analysis.

**Information table**
(Read-only) Shows the master table that supplies the data for this analysis.
Save with a static copy of the hierarchy
If you select this check box, the copy is a snapshot of the data at the current time. A date stamp is added to the heading to identify it as a static copy. You cannot modify the analysis or use it as the basis for a simulation.

If you do not select this check box, the copy is dynamic and works in the same way the original analysis worked.

**Active employees, Inactive employees**
(Read-only) These check boxes are dimmed. They reflect the selections for the original analysis.

Save in
Select a folder in which to save the copy.

### Export an Organization Analysis

In an organization analysis, the **Save As** menu enables you to export the current table of employee data to a Microsoft Excel worksheet or to a PDF file.

To export employee data, select **Excel** or **PDF** from the **Save As** menu.

From the dialog box that appears, select whether to display the information in a browser or save it in a file.

*Note:* The name, description, manager name, hierarchy code, and modified flag (“IsModified”) are always exported. The modified flag indicates whether the node is modified or not. A value of 0 indicates that the node was not modified. A value of 1 indicates that the node was modified. A value of 2 for a parent node indicates that a child node was modified. For example, if an employee moves from one department to another department, the employee will have a modified flag value of 1, and the department that the employee left will have a modified flag value of 2.

### Print an Organization Analysis

To print an organization analysis from analysis view, click the Print current view button on the toolbar.

In presentation view, right-click the organization chart and select **Print** to print the current view.

### Modify the Organization Structure

In an organization analysis, you can simulate a reorganization by moving employees and nodes within the organization tree. For example, you could move several departments to a division that is located in another city, or you could change the reporting relationships within an area of the organization. After making your changes, return to analysis view to see the effects of your restructuring. If you installed SAS Financial Management, you can export the results and view them in SAS Financial Management Studio.
Modifying the organization structure does not affect the underlying data or any other organization analyses. It simply creates a what-if scenario in which you can try out various changes to the organization.

*Note:* After you log off SAS Human Capital Management, you can no longer add measures to a modified organization analysis.

Here is a simple example of a simulation using the sample data. Assume that you want to make some changes in the Finance division.

![Organization Structure Diagram]

You decide to move two employees (Robert Johnson and Joan Burgess) to positions in the Consulting – Central Region department (under Sales ➔ Central U.S. Operations).
Here are the steps that you would follow:

1. First, make a copy of the existing analysis. (This step is recommended but not required.)
   a. On the Copy To dialog box, give the copy a name that identifies it as a simulation or reorganization.
   b. Do not select **Save with a static copy of the hierarchy**.

2. In the copy, from analysis view, click **Modify Organization** in the toolbar.
3. On the Modify Organization dialog box, drag the two employees’ names to the Consulting – Central Region node. The moved employee icons indicate that they are moved employees.

*Note:* If you are moving a node, drag the node link, not the icon.

The partial result looks like this:

![Modify Organization](image)

Click **OK** to save your changes. Following the save, notice the difference in the headcount and salaries for the Consulting – Central Region node and its parent nodes, as well as the Finance node. Notice, also, the new icons for the employees nodes that were modified.

![Headcount and Salaries](image)

In addition to using drag and drop, you can use the **Select** and **Move** buttons:

1. Click a node or employee name.
   
   *Note:* Click the text rather than the icon.

2. Click **Select**.
3. In the **Organization Structure** tree, click the target node.
4. Click **Move**.

To delete a node, select the node and click **Remove**.
Chapter 6
Geographic Analysis

About Geographic Analysis

A Quick Tour of Geographic Analysis
In a geographic analysis, you can analyze workforce data by geographic region. The screen displays a map of the world, a country, or a smaller geographic area. As you position the mouse pointer over a region, a data tip displays statistics for that area (for example, number of employees, average age, or minimum hourly wage). In table view, you can view detailed information about the selected area.

Some possible uses for a geographic analysis include determining where employees are located, viewing dependent coverage geographically, and viewing the population distribution of your company to determine optimal expansion locations.

Geographic analysis enables you to perform these actions:

- drill down to more detailed maps (for example, from the world to a country, and from a country to a state)
- select the statistics to be displayed on each map
- filter the results (for example, to display employees in particular job classifications)
- view employee data in a table
- print the current map or table view, or export the table view to a Microsoft Excel worksheet
Here is an example geographic analysis. The user has drilled down to a map of the United States. The mouse pointer is over the state of Illinois, and a data tip lists statistics for that state. Colored regions on each map indicate the number of employees in each area. A legend at the foot of the screen lists the colors and the associated ranges.

*Figure 6.1* Map view of a geographic analysis

1. Click **Back** to return to the last page visited. For example, if you are in map view, and then switch to table view, clicking **Back** will return you to map view.

   *Note:* If you make a copy of a geographic analysis, clicking **Back** returns you to the last page visited in the copy.

2. Click **** to copy the current geographic analysis.

3. Click **** to print the current view (map or table view).

4. Click **** to export geographic analysis data to a Microsoft Excel file (available in table view only).

5. Click **** to switch to map view, which displays the geographic analysis in a map.

6. Click **** to switch to table view, which displays the geographic analysis in tabular format.

7. Click **Workspace** to manage documents in the workspace.

8. Click **Options** to set options for this geographic analysis, including drill-down levels, color mapping, statistics to display, search criteria, and columns to display.

9. Use the search pane to filter the display.
To hide the search pane, click the Hide Left button. To redisplay the search pane, click the Show Left button. To hide the map, click the Hide Right button when the search pane is displayed.

10 The map link provides navigation back to higher-level maps.

11 The external actions drop-down menu contains links that your administrator has defined (such as Web page URLs or links to reports).

12 The display pane displays the map or table view.

13 Position the pointer on a shaded area to display information for that geographic region.

14 The legend displays the association between colored map regions and headcount ranges.

Note: Not all features are available to all users. In addition, the information that is displayed is subject to security, as applied by the administrator.

Map View

To open a geographic analysis, select the analysis from the workspace, a shortcut, or a link in an e-mail message. The analysis opens in map view, which displays a map of a geographic area. As you position the mouse pointer over an area, statistics for that area are displayed in a data tip.

Maps are organized into hierarchies, with the most comprehensive map at the highest level. For example, a map hierarchy might consist of the three levels World, Country, and State. Here is an illustration of navigating those map levels:

1. Open the analysis and view the world map.

![Map View](image)

When the mouse pointer is over the United States region of the map, a data tip displays statistics for that country.

2. Click the United States region of the map to drill down to the next level, a country map:
The legend displays the headcount ranges that are associated with each color on the map. When the mouse pointer is over the state of Illinois, a data tip displays statistics for that state.

3. Click the Illinois region of the map to drill down to the next level, a state map:

When the mouse pointer is over Cook County, a data tip displays statistics for that county. However, because there are no more levels in this hierarchy, clicking the Cook County region does not drill down to a lower-level map.

4. To return to a previous level, click a map link (such as **Country** or **World**) at the top of the screen.

- To customize a geographic analysis (by selecting colors, statistics, and map levels), click **Options**. (See “Customize a Geographic Analysis” on page 71.)
- To filter the statistics that are displayed for a map, use the search pane. (See “Filter a Geographic Analysis” on page 69.)
- At any point, you can click the Table View button to switch to a summary of employees that correspond to the current map. (See “Table View” on page 67.)
Table View

In geographic analysis, table view presents a summary of employee data. The data is filtered to match the geographic region that you selected in map view. For example, if you drill down to the state of Illinois in map view, and then switch to table view, you see a list of employees in Illinois.

- Click an employee name to view that employee's information in the Employee Browser.
- To select the columns that are displayed in table view, click Options. (See “Customize a Geographic Analysis” on page 71.)
- To filter the employees that are listed in table view, use the search pane. (See “Filter a Geographic Analysis” on page 69.)
- To switch to map view, click the Map View button 🌐.

Create a Geographic Analysis

To create a geographic analysis, select New Geographic Analysis from the Tasks menu of SAS Human Capital Management.

On the New Geographic Analysis dialog box, follow these steps:
1. Enter a name for the analysis.
2. (Optional) Enter a description, which can be used in searches and displayed in the workspace. A description can contain alphanumeric characters, spaces, periods, commas, hyphens, and underscores.

3. From the Information table list, select a table, such as the Employee Master table, to provide the data for the analysis.

4. Select Active employees, Inactive employees, or both to display those employees' records. If the source table does not contain a column that denotes active or inactive employees, these check boxes are dimmed.

5. Decide which maps you want to display. The administrator defines a hierarchy of maps, from most general to most specific. When you create a geographic analysis, you can choose to display all the maps or a subset of the maps.

   For example, if the available maps are World, Country, State, and County, you might decide to begin at the World level or at the Country level. If you did not want to display county maps, you would make State your end level.

6. Select a folder in which to save the analysis.

7. Click OK.

The geographic analysis is saved, and the top-level map is displayed.
So far, the map is not very interesting or informative. The legend at the foot of the map displays the headcount, but nothing more. You need to modify the analysis to add statistics. At the same time, you can modify the colors that are used in the map, define search criteria for filtering the data that is displayed in the analysis, and select the columns that are displayed in table view.

For information about setting any of these options, see “Customize a Geographic Analysis” on page 71.

Filter a Geographic Analysis

Use the search pane to filter the data in a geographic analysis. The search filter affects both the statistics that are displayed in map view and the data that is displayed in table view.

In this example, the user has filtered the data to select only employees whose last name includes the string smith. Notice that the employee headcount is significantly smaller in the filtered map.

Click the Table View button to see the search results in tabular format.
For information about valid search terms, see “Search Functionality” on page 43.

The geographic analysis has several default search columns. To modify the columns that are used as search criteria, or to modify the columns that are displayed in table view, click **Options**. See “Customize a Geographic Analysis” on page 71.

### Print a Geographic Analysis

To print a geographic analysis from map view or table view, click the Print button in the toolbar.

### Export a Geographic Analysis

To export a geographic analysis to a Microsoft Excel file:

1. In the geographic analysis, click the Table View button in the toolbar.
2. Click the Export button.

### Copy a Geographic Analysis

To make a copy of a geographic analysis:

1. From map view, click the Copy To button.
2. In the Copy To dialog box, enter a name for the copy.
3. (Optional) Enter a description, which can be used in a search.

4. Select a location in which to save the copy.

5. Click **OK**.

---

**Customize a Geographic Analysis**

In the geographic analysis, click **Options** to modify the color range, statistics, map levels, legend, search options, and columns as follows:

1. The **Map Colors** section controls the color range for the map. The number of intervals to display is based on the population for a map. **Start color** marks the lowest headcount, and **End color** marks the highest headcount. All other intervals use colors in between. The colors and their intervals are displayed in the map legend.

   From the two color palettes, select starting and ending colors for your map.

2. In the **Statistics** section, you can select statistics to display in the data tip when the mouse pointer is over a map region.

   a. Select a measure from the **Available measures** list.

   b. From the **Statistics** drop-down list, select a function to apply to this measure.

   c. Use the right and left arrows to move columns between the **Available measures** and **Selected measures** lists.
The selected statistics appear in the data tip for a region.

*Note:* The employee population is always displayed in the data tip.

3. **Levels and Statistics:** The administrator determines the map level hierarchy. Typically, several levels are available (for example, world, country, and state). For each analysis, you can select the levels to display and the statistics to associate with each level.

   a. To change the starting map or the number of drill-down maps available, modify the **Hierarchy start level** and **Hierarchy end level**.

      *Note:* You can change the **Hierarchy start level** and **Hierarchy end level** only from map view.

   b. For each level, select an **Available hierarchy level** and select the check boxes for the statistics you want to display at that level.

   c. To change the order in which statistics are displayed, use the up and down arrows.

4. **Legend Label:** Specify the label for the legend that appears below the map.

5. **Search:** Select the columns on which users can search in this analysis.
a. Use the right and left arrows to move columns between the **Available columns** and **Selected columns** lists.

b. In the **Selected columns** list, use the up and down arrows to change the order in which the columns appear.

6. **Search Results**: Select the columns to appear in table view, just as you did with the search criteria. The employee ID and employee name are always displayed, regardless of your selections.

7. Click **OK**.

*Note*: Search options apply only to the current analysis.
Chapter 7
Viewing the Standard Reports

About the Standard Reports

In SAS Human Capital Management, a number of standard reports are available in the workspace, under SAS Folders ➔ Products ➔ SAS Human Capital Management ➔ Reports. Some of these reports might also be available in the SAS HCM Content portlet or in the Shortcuts list.

To run a report, click its name. The output is filtered to show only the rows that you have permission to view. Typically, you can view data for your level of the organization and below. However, additional filtering might apply.

There are two types of standard reports:

- stored processes. Some of the stored processes prompt for optional parameter values. Dialog boxes that gather additional information to use in creating a report might include
icons you can use to provide information. The Calendar button helps you select a date. The Search button helps you browse for information to select.

- **SAS reports.** A SAS report opens in SAS Web Report Studio. To interact with the report, you must refresh it, using the link at the top of the report. You can filter, sort, and rank the data that is shown in tables, crosstabs, and graphs. With multidimensional data, you can drill down on data in crosstabs and graphs and drill through to the underlying data. For more information about using SAS Web Report Studio, see the online Help for SAS Web Report Studio.

### The Standard Reports

#### The Absence Reports

The Absence reports display table and graph output of absence duration by type, gender, year, organization, EEO class, and ethnicity.

<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Duration by Absence Type and Gender</td>
<td>SAS report</td>
<td>A table of absence duration by type, gender, and year. A matrix of bar charts of absence duration by type, gender, and year.</td>
</tr>
<tr>
<td>Absence Duration by Absence Type and Org. Hierarchy</td>
<td>SAS report</td>
<td>A table of absence duration by type, organization, and year. A matrix of bar charts of absence duration by type, organization, and year.</td>
</tr>
<tr>
<td>Absence Duration by Absence Type</td>
<td>SAS report</td>
<td>A table of absence duration by type and year. A bar chart of absence duration by type and year.</td>
</tr>
<tr>
<td>Report</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Absence Summary by Weekday</td>
<td>Stored process</td>
<td>A set of bar charts that show the absence count for each weekday.</td>
</tr>
</tbody>
</table>
|                              |                  | **Number of Years**  
|                              |                  | Number of years to include in the report. Ignored if **Begin Date** is specified. Default: 3.                                                  |
|                              |                  | **Begin Date**  
|                              |                  | First date to begin collecting data. Default: **End Date - Number of Years**.                                                              |
|                              |                  | **End Date**  
|                              |                  | Last date to begin collecting data. Default: the current date.                                                                                |
|                              |                  | **Duration Length**  
|                              |                  | If present, filters the data to include only absences of the specified length (in days).                                                   |
|                              |                  | **Absence Type**  
|                              |                  | If present, filters the data to include only the specified absence type. If you omit this parameter, the stored process generates a separate bar chart for each absence type. |
| Average Duration of Absences | Stored process   | **Begin Date**  
|                              |                  | First date to begin collecting data. Default: **End Date - Number of Years**.                                                              |
|                              |                  | **End Date**  
|                              |                  | Last date to begin collecting data. Default: the current date.                                                                                |
|                              |                  | **Number of Years**  
|                              |                  | Number of years to include in the report. Ignored if **Begin Date** is specified. Default: 3.                                                  |
| Summary of Absence Duration  | Stored process   | A table with absence statistics by absence type, including absence occurrences, total days absent, average length of an absence type, and median length of an absence type. |
| Absence Trends               | SAS report       | A table of absence duration by type, EEO class, and ethnicity. A bar chart of absence duration by type and EEO class. A bar chart of absence duration by type and ethnicity. |

**The Applicant Reports**

The Applicant reports show job distribution by job group code or by recruitment source.
### Applicant Distribution by Job Group Code

<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicant Distribution by Job Group Code</td>
<td>Stored process</td>
<td>A graph showing the number of applicants for each job code, over a specified time period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Number of Years</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of years to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ignored if <strong>Begin Date</strong> is specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 30.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Begin Date</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>First date to begin collecting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: <strong>End Date - Number of Years</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>End Date</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Last date to begin collecting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: the current date.</td>
</tr>
</tbody>
</table>

### Applicant Distribution by Source

<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicant Distribution by Source</td>
<td>Stored process</td>
<td>A graph that shows the number of applicants for each recruitment source type, over a specified period of time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Number of Years</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of years to include in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ignored if <strong>Begin Date</strong> is specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 30.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Begin Date</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>First date to begin collecting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: <strong>End Date - Number of Years</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>End Date</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Last date to begin collecting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: the current date.</td>
</tr>
</tbody>
</table>

### The Compensation Reports

The Compensation reports display salary information by a variety of measures.
<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Annual FTE Salary by Ethnicity</td>
<td>SAS report</td>
<td>A table of average annual FTE salary by ethnicity. A bar chart of average annual FTE salary by ethnicity.</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Ethnicity</td>
<td>Stored process</td>
<td>A bar chart of average Full Time Equivalent (FTE) salaries, organized by ethnicity.</td>
</tr>
<tr>
<td>Annual FTE Salary by Ethnicity and LOS</td>
<td>SAS report</td>
<td>A table of annual FTE salary by length of service, ethnicity, and gender. A bar chart of annual FTE salary by length of service, ethnicity, and gender.</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Gender</td>
<td>Stored process</td>
<td>A bar chart of average FTE salaries, organized by gender.</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Ethnicity and Gender</td>
<td>SAS report</td>
<td>A table of average annual FTE salary by ethnicity, and gender. A bar chart of average annual FTE salary by ethnicity, and gender.</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Job Group</td>
<td>SAS report</td>
<td>A table of average annual FTE salary by job group. A bar chart of average annual FTE salary by job group.</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Job Group</td>
<td>Stored process</td>
<td>A bar chart of average FTE salaries, organized by job group.</td>
</tr>
<tr>
<td>Report</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Annual FTE Salary by Job Group and Gender</td>
<td>SAS report</td>
<td>A table of average annual FTE salary by job group and gender. A bar chart of average annual FTE salary by job group and gender.</td>
</tr>
<tr>
<td>Average Percent Salary Increase by Action Code</td>
<td>Stored process</td>
<td>A bar chart that shows the percentage salary increase over the past three years, by action code.</td>
</tr>
<tr>
<td>Average Salaries for Job Groups by Gender</td>
<td>Stored process</td>
<td>A bar chart showing the average FTE salary for each job group in the organization, organized by gender.</td>
</tr>
<tr>
<td>Average Salary Distribution using FTE</td>
<td>Stored process</td>
<td>A bar chart showing the average salary distribution using FTE for each job group in the organization, organized by gender.</td>
</tr>
<tr>
<td>Salaries by Ethnicity, Gender, Years of Service</td>
<td>Stored process</td>
<td>A bar chart of total salaries for active employees. The x-axis measures total salary. The y-axis displays years of service, subdivided by ethnicity and gender.</td>
</tr>
<tr>
<td>Salary Distribution by Age</td>
<td>Stored process</td>
<td>A graph of salary distributions within a specified range of ages and salaries.</td>
</tr>
<tr>
<td><strong>Please select a maximum age</strong></td>
<td></td>
<td>The upper end of the age range that is included in the output.</td>
</tr>
<tr>
<td><strong>Please enter a maximum salary value</strong></td>
<td></td>
<td>The upper end of the salary range that is included in the output.</td>
</tr>
<tr>
<td>Salary Grade Distributions</td>
<td>Stored process</td>
<td>A table showing the salary grade distributions by job group.</td>
</tr>
<tr>
<td><strong>Number of Years</strong></td>
<td></td>
<td>Number of years to include in the report. Ignored if <strong>Begin Date</strong> is specified. Default: 3.</td>
</tr>
<tr>
<td><strong>Begin Date</strong></td>
<td></td>
<td>First date to begin collecting data. Default: End Date - Number of Years.</td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td></td>
<td>Last date to begin collecting data. Default: the current date.</td>
</tr>
<tr>
<td><strong>Pay Level Code</strong></td>
<td></td>
<td>Enter a value to restrict the output to that pay level code. Default: all pay level codes.</td>
</tr>
</tbody>
</table>
### The Standard Reports

The Employee reports display employee demographics and personnel information.

#### The Employee Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salary Increase Trends</td>
<td>Stored process</td>
<td>A set of graphs showing the percent salary change that is attributed to each action type over time.</td>
</tr>
</tbody>
</table>
|                                 |               | **Number of Years**  
|                                 |               | Number of years to include in the report. Ignored if **Begin Date** is specified. Default: 3.                                                |
|                                 |               | **Begin Date**       
|                                 |               | First date to begin collecting data. Default: **End Date** - **Number of Years**.                                                          |
|                                 |               | **End Date**         
|                                 |               | Last date to begin collecting data. Default: the current date.                                                                              |

---

**Action Code by Ethnicity**  
A bar chart that shows the frequency of different HR actions, organized by ethnicity.

**Age Distribution Pyramid**  
A graph showing the distribution of male and female employees by age.

**Average Annual FTE Salary by EEO Class**  
A graph showing average FTE salaries for each Equal Employment Opportunity (EEO) classification.
<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EEO-1</td>
<td>Stored process</td>
<td>A table that shows employee count by EEO classification, ethnicity, and gender.</td>
</tr>
<tr>
<td>EEO-1: Job Category by Ethnicity Code and Gender Code</td>
<td>Stored process</td>
<td>A table that shows employee count by EEO classification, ethnicity, and gender.</td>
</tr>
<tr>
<td>Employee Age Distributions</td>
<td>Stored process</td>
<td>A bar chart showing number of employees for each age range.</td>
</tr>
<tr>
<td>Employee Demographics by Age and Length of Service</td>
<td>Stored process</td>
<td>A table that shows the average annual salary and employee count for an organization, grouped by age range and then by length of service.</td>
</tr>
<tr>
<td>Employee Demographics – EEO Class and Ethnicity</td>
<td>SAS report</td>
<td>A table of average annual employee salary and service years by class, gender, and ethnicity. A matrix of bar charts of average annual employee salary by EEO class, ethnicity, and gender.</td>
</tr>
<tr>
<td>Headcount Totals Across Divisions</td>
<td>Stored process</td>
<td>A pie chart of employee headcount, separated by division.</td>
</tr>
<tr>
<td>New Hires by Division and Department</td>
<td>Stored process</td>
<td>A table of employees who were hired since a specified date, along with their division and department membership.</td>
</tr>
<tr>
<td>Employees Hired Since</td>
<td></td>
<td>First hire date to include.</td>
</tr>
<tr>
<td>Number of Employees by Years of Service</td>
<td>Stored process</td>
<td>A bar chart of headcount by years of service.</td>
</tr>
<tr>
<td>Service Years of Separated Employees</td>
<td>Stored process</td>
<td>A bar chart that plots years of service against the count of employees who have left the company.</td>
</tr>
<tr>
<td>Total Headcount by Division and Department</td>
<td>Stored process</td>
<td>A table that shows the number of employees for each division and department.</td>
</tr>
<tr>
<td>Workforce Percentage Above 40</td>
<td>Stored process</td>
<td>A pie chart showing the number of employees who are older than 40 (Y) and who are not (N).</td>
</tr>
</tbody>
</table>

**The Position Reports**

The position reports display open position information.
The Retirement Reports

The Retirement reports show employee eligibility for retirement and termination information, based on certain criteria that might include type, reason, year, salary, years of service, and job group.

### Retirement Eligibility by Division and Department

<table>
<thead>
<tr>
<th>Corporation</th>
<th>Division</th>
<th>Department</th>
<th>Count</th>
<th>Annual Salary</th>
<th>Service Years</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S.</td>
<td>Administration</td>
<td>Corporate Comm.</td>
<td>1</td>
<td>$18,090.92</td>
<td>11.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>1</td>
<td>$18,090.92</td>
<td>11.0</td>
</tr>
<tr>
<td></td>
<td>Human Resources</td>
<td></td>
<td>2</td>
<td>$39,991.92</td>
<td>9.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>2</td>
<td>$39,991.92</td>
<td>9.5</td>
</tr>
<tr>
<td></td>
<td>Finance</td>
<td>Accounting</td>
<td>4</td>
<td>$42,026.21</td>
<td>9.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>4</td>
<td>$42,026.21</td>
<td>9.6</td>
</tr>
<tr>
<td></td>
<td>Purchasing</td>
<td></td>
<td>2</td>
<td>$35,961.25</td>
<td>13.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>2</td>
<td>$35,961.25</td>
<td>13.5</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
<td>Central U.S.</td>
<td>2</td>
<td>$45,489.61</td>
<td>10.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operations</td>
<td></td>
<td>$45,489.61</td>
<td>10.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>2</td>
<td>$45,489.61</td>
<td>10.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Product Delivery</td>
<td>1</td>
<td>$10,997.50</td>
<td>14.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtotal</td>
<td>1</td>
<td>$10,997.50</td>
<td>14.0</td>
</tr>
</tbody>
</table>

### The Standard Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Positions</td>
<td>Stored process</td>
<td>A table that lists currently open positions.</td>
</tr>
<tr>
<td>Employees Eligible for Retirement</td>
<td>Stored process</td>
<td>A table of active employees who have at least 20 years of employment, or who are 62 or older</td>
</tr>
<tr>
<td>Retirement Eligibility by Division and Department</td>
<td>Stored process</td>
<td>A table of active employees who meet any of these three sets of conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 20 or more years of service and an annual salary less than 100,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• over age 62, with an annual salary less than 100,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• over age 52, with at least 15 years of service and an annual salary less than 100,000</td>
</tr>
<tr>
<td>Report</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminations by Time and Reason</td>
<td>SAS report</td>
<td>A table that displays terminations by type, reason, year, salary, and years of service. A bar chart that displays terminations by service years, type, and job group.</td>
</tr>
</tbody>
</table>
Chapter 8
Forecasting in SAS Human Capital Management

About Forecasting

The forecasting feature in SAS Human Capital Management predicts the value of a variable, based on the variable’s historical value. The forecast variable represents a measure of interest to the organization, such as headcount, voluntary terminations, or involuntary terminations. You can generate a graph of the results, as in this example, which shows predicted change in headcount within a company.

To generate the data, an ETL job calls SAS forecasting procedures. The forecasting software uses sophisticated automatic model selection techniques to choose the best-fitting model for the time series. It reconciles forecasts at different levels of aggregation, so that the forecast for a division is consistent with the forecasts for the individual departments that make up that division.

To view the results, you call a stored process that generates a graph of the forecast results. The graph displays the historical and predicted value of a variable. Users can filter the results by classification variables such as job group code, EEO-1 classification, or the job’s permanence (such as regular or temporary). Here are some possible uses:
• projecting fluctuations in contract hiring over the next two years
• projecting headcount changes in a particular division
• projecting voluntary terminations (retirements and resignations) for a particular job group

A forecast does not make predictions for individual employees. It bases its predictions solely on the forecast variable's historical values, not on other variables that might contribute to its value. The more data points available, the more accurate the predictions.

---

Run a Forecasting Report

The forecasting reports are located in **SAS Folders ➔ Products ➔ SAS Human Capital Management ➔ Reports ➔ Forecast**.

This example illustrates possible parameters and values for a monthly forecast. To run a forecasting report, click the report name, such as *Monthly Forecast*, and then respond to the prompts.

![Stored Process Monthly Forecast](image)

The specific prompts and possible values are site-specific. Here are some of the possible prompts and values:

**Select the forecast variable**

The forecast variable is the variable whose value you want to forecast. The available variables are site-specific. Some possible selections are as follows:

- **Total Headcount** is the projected headcount during the forecast period.
- **Voluntary Terminations** is the number of employees that are projected to leave the organization voluntarily during the forecast period.
• **Involuntary Terminations** is the number of employees that are projected to leave the organization involuntarily during the forecast period.

• **Headcount Change** is the projected change in headcount (additions or subtractions) during the forecast period.

• **New Hires** is the projected new hires during the forecast period.

• **Internal Movement** is the projected internal movement (such as employees moving to different departments) during the forecast period.

**Forecasting Graph Type**

The graph type parameter specifies the type of graph in which to convey the historical and projected values of the forecast variable. By default, these selections are available:

• **Vertical Bars** is a traditional histogram. Confidence intervals can be displayed on the Time axis or on top of the histogram.

• **Floating Lines** is a modified line graph. Confidence intervals are displayed as gray bar areas above and below the forecasted line.

• **Floating Arrows** is a scatter plot that uses arrow symbols as markers.
• **Statistical Graph** is a traditional statistical graph. Confidence intervals are displayed in areas above and below the line plot.

Class Variable
These prompts enable you to limit the forecast to certain employee categories. The default variables are as follows:

• **Select EEO classification** specifies the Equal Employment Opportunity classification for an employee.

• **Select job group** specifies the job group code.

• **Select union** specifies the union membership code.

• **Select evaluation result** specifies the results of evaluations. For example, in the sample data, some possible evaluation results are **Meets Expectations**, **Often Exceeds Expectations**, and so on.

• **Select permanence** specifies a job classification in terms of permanence—for example, **Regular** or **Temporary**.

Hierarchy Variables
The hierarchy variables select the part of the organization that is included in the forecast.

• **Select the Organization management** specifies the organization management. Selection of an organization management enables the **Select the Corporation management** drop-down menu.

• **Select the Corporation management** specifies the corporation management. Selection of a corporation management enables the **Select the Division management** drop-down menu.
• Select the Division management specifies the division management. Selection of
a division management enables the Select the Department management drop-
down menu.
• Select the Department management specifies the department management.
Selection of a department management enables the Select the Group management
drop-down menu.
• Select the Group management specifies the group management.

Graph Output Parameters
These parameters determine the characteristics of the graph that is produced. The
default parameters are as follows:
• Confidence Interval Display Type (Vertical Bars graphs only) specifies the way
the confidence interval values are displayed on a Vertical Bars graph. It can have
one of two values: Upper and Lower Confidence interval range or Plus and
Minus range values.
• Number of historical values specifies the number of historical data points to be
used in the graph. (It does not change the data points that were used in generating
the forecast data.)

A typical value is 10–15 data points. As this number gets larger, the graph might
become unreadable.
• Confidence Range Location (Vertical Bars graphs only) specifies where the
confidence range is shown on a Vertical Bars graph. It can have one of two values:
  • Top of Confidence Interval shows the range above the bars.
  • On the time Axis shows the range below the value of each data point on the
    Time axis.
• Width of the graph in pixels specifies the width of the graph by the number of
  pixels.
• Height of the graph in pixels specifies the height of the graph by the number of
  pixels.
Chapter 9
Displaying Key Metrics with SAS BI Dashboard

About SAS BI Dashboard

Dashboards are used for the graphical display of key metrics within an organization. The information represented in a dashboard can be quickly interpreted, often for decision-making purposes.

SAS BI Dashboard is an application for creating and displaying dashboards. In SAS Human Capital Management, the Home page can be configured so that users can select from available dashboards for display.

This chapter explains how you can create a dashboard using the SAS Human Capital Management data source. For more information about the SAS Human Capital Management metrics, see Appendix A1, “Metrics in SAS Human Capital Management,” on page 121. For more information about creating dashboard projects, see the online Help for the SAS BI Dashboard.

Creating a BI Dashboard Project

About Dashboards in SAS Human Capital Management

You can use metrics that are provided with SAS Human Capital Management to create a dashboard. A dashboard can display metrics in an interactive graph that uses Adobe Flash to enable users to traverse large amounts of data.
Overview of Creating a Dashboard

To create a dashboard, you define its components in this order:

1. First, create the data model, which defines the data source, such as an information map or table. SAS Human Capital Management provides an additional data source, the HCM metrics (Saratoga metrics or user-defined metrics).

2. Define the ranges, which are the intervals against which the metrics are interpreted. For example, different intervals in a range might be defined as being On Target or Below Target.

3. Create an indicator, which integrates the data model and range and defines the way the data is displayed. For example, the metrics might be displayed in a graph or as a key performance indicator (KPI). If the display includes a gauge, you can select from a wide variety of gauge types, such as a traffic light, a slider, or a dynamic speedometer.

4. Create a dashboard, which is a collection of indicators that are displayed together.

These components can be reusable. For example, you might use the same data model with several indicators for different effects. Or if the range applies to multiple data models, you can use the same range in different indicators.

Create the Data Model

To create the data model for the example:

1. From the Manage list on the Home page, select Manage Dashboards.
   
   Note: This link is available if you have the appropriate permissions.

   The SAS BI Dashboard page appears.
2. Click **New Indicator Data**, or select **Indicator Data** from the **New** drop-down menu.

3. Enter a name, and then click **OK**.

4. Select **SAS Human Capital Management** from the **Data source** drop-down menu.

   The **Metric Server URL** is automatically populated with the Web service for the SAS Human Capital Management metrics.

5. If necessary, change the URL and click **Set Server**.

6. For the **Metric Type**, select **Saratoga**. HCM represents custom measures that are defined at the site.

7. For this example, leave the **Metric Hierarchy** empty.

   If you do not select a hierarchy, the measures are aggregated for the entire company.

   If you select a hierarchy, the dashboard displays a subset of that hierarchy, based on the user's place in the hierarchy.

8. From **Metric Category**, select **Compensation**.

9. Select the **Create with multiple dimensions** check box.

   With this option, you can subset the data by date in your dashboard. If you do not select this option, each metric is displayed separately in a single row, with a separate column for each date.

10. Select a **Start Date**, such as **2001–12–31**.

11. Select an **End Date**, such as **2009–12–31**.

    At this point you will notice that the **Preview Design** section of the page has been populated.

12. On the **Data Mapping** tab, select only the check boxes for **Measure, Date, and Value**.

13. Select **Value** from the drop-down **Category Label** menu for measure.
14. Click **Submit**.
15. Click **Save**, specify a folder to save your indicator data, and then click **Save**.

**Create the Range**

To create the range for this project:
1. Click **New Range**, or select **Range** from the **New** drop-down menu.
2. Enter a range name, and then click **OK**.
3. The range for this project will include three intervals: **Below Target**, **On Target** and **Above Target**.
   - Click **Add Interval**. Type 8000 for an upper bound, and then click **OK**.
   - Click **Add Interval**. Type 13000 for an upper bound, and then click **OK**.
4. Leave the first **Code Interval** selection as **Below Target** (the default).
5. Modify the second and third **Code Interval** selections to reflect **On Target** and **Above Target**, respectively.
   - Notice that the label and color changes for each interval. Both the labels and the colors can be modified to suit your preferences.
6. Click **Save**, specify a folder to save your range, and then click **Save**.

**Create the Indicator**

To create the indicator for this project:
1. Click **New Indicator**, or select **Indicator** from the **New** drop-down menu.
2. Enter a name for the indicator.
3. From the **Display type** drop-down list, select **Interactive Summary and Bar Chart**.
   - **Note:** There are a number of choices for displaying the metrics. After you finish creating this project, you can modify the indicator or create additional indicators to display the results in different ways.
4. Browse and select the indicator data you created.
5. Browse and select the range you created.
6. Click **OK**.
7. Select or provide values for required fields with available drop-down options.
8. Click **Save** , specify a folder to save your indicator, and then click **Save**.

**Create the Dashboard**

To create the dashboard:
1. Click **New Dashboard**, or select **Dashboard** from the **New** drop-down menu.
2. Provide a name for the dashboard, and then click **OK**.
3. Click **Save**, specify a folder to save your dashboard, and then click **Save**.

---

**Viewing the Project**

After you create the example project, you can view it in either of two ways:

- If the Home page of SAS Human Capital Management displays dashboards, you can select the dashboard from the selector at the foot of the page.

  *Note*: Your administrator determines what appears on your Home page.

- From the Home page, you can also click the **My Portal** link. In the portal, you can add a dashboard portlet.

To add a SAS BI Dashboard portlet to your portal page, follow these steps:
1. On the Home page, click **My Portal**.
2. In the portal, select **Customize** ⇒ **Edit Page** ⇒ **Edit Page Content**.
3. On the Edit Page Content page, select **Add Portlets**.
4. For the **Portlet type**, select **SAS BI Dashboard Portlet**.
5. Give the portlet a name and click **Add**.

6. Click **Done**.
7. If your portal page uses a column layout, you can select the column in which your portlet should appear. If your portal page uses a grid layout, you must add the portlet to the grid. You can spread the SAS BI Dashboard portlet over multiple contiguous rows and columns, as shown here:

![Edit Page Content](image)

For details about the layout of portlets on a page, consult the online Help for the portal.

8. Click **OK**.
Chapter 10
Creating Reports with SAS Web Report Studio

Using SAS Web Report Studio .......................................................... 97
Create a Report .................................................................................. 98
Edit the Sample Report ................................................................. 103
View the Sample Report ................................................................. 105

Using SAS Web Report Studio
SAS Web Report Studio is a Web-based application that enables you to create, view, and organize reports. You can use SAS Web Report Studio for the following tasks:

- **Creating reports.** You can create a report that is based on relational or multidimensional data sources (tables or cubes). SAS Web Report Studio does not interact with data sources directly. Instead, you open an information map that references a data source.

  A Report Wizard simplifies the creation of reports that use an information map. In the Edit mode, you can both create and edit sophisticated reports that have multiple data sources, each of which can be filtered. Reports can include various combinations of list tables, crosstabulation tables, graphs, images, and text. Using the Edit mode, you can adjust the style to globally change colors and fonts.

- **Viewing and working with reports.** When you view a report, you can filter, sort, and rank the data that is shown in tables, crosstabulations, and graphs. With multidimensional data, you can drill down on data in crosstabulations and graphs and drill through to the underlying data.

  Note: You cannot drill down in reports that are based on cubes or tables. Only information maps built on cubes and tables can be used in conjunction with application linking.

- **Organizing reports.** You can create folders and subfolders for organizing your reports. Users can use keywords to find the reports that they need. Reports can be shared with others or kept private.

- **Printing and exporting reports.** You can preview a report in PDF and print the report, or save and e-mail it later. You have control over many printing options, including page orientation, page range, and size of the tables and graphs. You can also export data as a spreadsheet and export graphs as images.

For more information about using SAS Web Report Studio, see the SAS Web Report Studio Help and the *SAS Web Report Studio: User’s Guide*, both of which are available from the
Create a Report

The following example illustrates using SAS Web Report Studio to view the Employee Master table (EMPMAST).


3. In Step 1 of the wizard, click Select Data Source and select the data source: the information map for the Employee Master table.
4. Select the following items to appear in the report:

   - Employee Name
   - Job Title
   - Annual Salary
   - Annual Salary (2)

   **Note:** Add Annual Salary twice to the report so that you can perform a different calculation on each of the two occurrences.

   - Evaluation Result
   - Manager Name

   Click Next.

5. Define the format for both Annual Salary items as a currency field with no decimal places.
6. Select **Predefined** as the format type for **Evaluation Result**, and select **$EVALRES** as the format.

   ![Filter or format the data](image)

   ![Define a Format](image)

   Click **Next**.

7. Create group breaks by manager name and then by job title. Do not create a new page for each value.
Click Next.

8. Select both table and graph for the output.

Select all data items except Annual Salary (2) to display in the table.

For the graph, select Bar as the graph type, Annual Salary (2) as the measure (Bar height), and Evaluation Result as the category (Bars).

Click Next.

9. Define the section header text for the report as Annual Salary.
10. Click **Finish**. The report opens in Edit mode.

11. Save the report by selecting **File** → **Save As**.

**TIP** If you are creating reports that might contain confidential information, we recommend that you always choose **Data is automatically refreshed** from the **Type** drop-down list. Then when other users open your report, security is applied and the data is refreshed. Users see only the data that they are authorized to view. If you select **Data can be manually refreshed**, a static copy of the report is saved. If other users open the report, they view the same data that you viewed, regardless of their security settings. (If they try to refresh the data, security is applied.)
Edit the Sample Report

After you create the report, edit its definition as follows:

- Change the summarization options for the graph.
- Create a section filter that prompts for manager name.
- Create another filter, for the table only, that selects employees with an evaluation rating of **Constantly Exceeds Expectations** or **Often Exceeds Expectations**.

1. **(Optional) Modify the summarization options.**

   *Note:* Summarization options are available only after you have defined a data source, and are available only to advanced users. Skip to step 2 if you do not have summarization options.

   By default, measures are aggregated as sums. For the graph, which will display salaries by evaluation result codes, we want to display average salary, not sums.

   a. From the **Data** menu, select **Summarization Options**.

   ![Summarization Options](image)

   b. On the Summarization Options page, define the aggregation for **Annual Salary (2)** as **Average** rather than **Sum**.

   ![Summarization Options](image)

   Click **OK**.
2. Add a section filter:
   a. From the Data menu, select Section Filters.
   b. In the Section Filters dialog box, click New.
   c. From the Data Item list, select Manager Name.
   d. Select Contains as the Operator value.
   e. Select Prompt user to enter values.
   f. In the Prompt text box, type Enter manager name.
   g. In the Default value box, type a name such as Marshall (assume this is the name of the CEO).
   h. Select Ignore case.

   ![Create Custom Filter dialog box]

   i. Click OK and then OK again to exit the Section Filters dialog box.

3. Create a filter that restricts the table to certain evaluation result codes.

   Note: A section filter affects all output types (in this example, both the table and the graph). This filter will affect only the table.
   a. Right-click the table and select Filter and Rank.
   b. In the Data Item list, select Evaluation Result.
   c. Select the Filter radio button.
   d. Select Filter on formatted values.
   e. In the Type a value to add box, type each of the following values and click the Add value button to move the value to the Selected values list.
      - constantly exceeds expectations
      - often exceeds expectations
f. Select **Ignore case**.
   For these filters, the operator is always equals (=). You must type the entire formatted string, exactly as it is stored. However, you can specify whether the filter is case sensitive.

g. Click **OK**.

4. Save your report.

---

**View the Sample Report**

To view the sample report that you created:

1. In the workspace, select the report.
   The report opens in SAS Web Report Studio in View mode and prompts you for a manager name.

2. At the prompt, enter a manager's name, or part of a manager's name, and click **View Report**.
3. The report is displayed.

4. To select a different manager name and refresh the data, select **Data ⇒ Refresh Data** from the toolbar.
Chapter 11
Multidimensional Analysis

Overview of Cubes and Information Maps

A cube is a set of data that is organized and structured in a hierarchical, multidimensional arrangement. SAS cubes are designed to offer fast data access and efficient data storage. Cubes can be used as input for information maps and can be explored directly in SAS Web Report Studio.

The following table lists the pregenerated cubes, and their corresponding information maps, that are provided with SAS Human Capital Management:

<table>
<thead>
<tr>
<th>Cube</th>
<th>Description</th>
<th>Information Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSHCUBE</td>
<td>Absence History Cube</td>
<td>ABSHCUBE_MAP</td>
</tr>
<tr>
<td>ACTHCUBE</td>
<td>Action History Cube</td>
<td>ACTHCUBE_MAP</td>
</tr>
<tr>
<td>APPHCUBE</td>
<td>Applicant History Cube</td>
<td>APPHCUBE_MAP</td>
</tr>
<tr>
<td>EMPCUBE</td>
<td>Employee Master Cube</td>
<td>EMPCUBE_MAP</td>
</tr>
<tr>
<td>HDSMCUBE</td>
<td>Headcount Summary Cube</td>
<td>HDSMCUBE_MAP</td>
</tr>
<tr>
<td>OPOSCUBE</td>
<td>Open Positions Cube</td>
<td>OPOSCUBE_MAP</td>
</tr>
<tr>
<td>OPSCUBE</td>
<td>Open Positions Summary Cube</td>
<td>OPSCUBE_MAP</td>
</tr>
<tr>
<td>SALHCUBE</td>
<td>Salary History Cube</td>
<td>SALHCUBE_MAP</td>
</tr>
<tr>
<td>TERMHCUBE</td>
<td>Terminations History Cube</td>
<td>TERMHCUBE_MAP</td>
</tr>
<tr>
<td>TIPCUBE</td>
<td>Time in Position Cube</td>
<td>TIPCUBE_MAP</td>
</tr>
</tbody>
</table>
The example in this chapter uses an information map that was generated from the Absence History Cube. For more information about using SAS Web Report Studio, see the online Help.

Open and View the Data

Complete these steps:

1. From the Manage menu on the Home page, select Workspace.

2. Select SAS Folders ⇒ Products ⇒ SAS Human Capital Management ⇒ Data Sources ⇒ Information Maps.
   
   Note: We recommend that you use an information map in order to share a data exploration.

3. Select ASHCUBE_MAP.
   
   The cube opens in SAS Web Report Studio with default row and column selections.

4. Select File ⇒ Save As.

5. Save the data exploration with a suitable name.

   Note: In order to share a data exploration, you should create it from an information map, and both the information map and the data exploration must be in a shared folder.
Chapter 12
Metrics and Scorecards

Using SAS Strategy Management

SAS Strategy Management enables you to create a scorecard to measure the performance of an organization. A scorecard highlights selected measures that enable you to tell at a glance how an organization is performing. The example in this chapter shows how to create a simple key performance indicator (KPI) scorecard using data from SAS Human Capital Management.

Create a Scorecard

To create the sample scorecard, perform the following steps:

1. Select the New HR Scorecard task.
2. Select Project ⇒ New Project.

3. Specify the location to save your project, and then click Next.

4. Assign a name to the project, specify an optional description, and select a time hierarchy. Click Next.

5. Select a template to associate with the project. For this project, select KPI Template. Click Next.

6. Click the Yes radio button to enable the Select a hierarchy view. If you want a separate scorecard for each of the different levels in your organizational hierarchy, then you must import a dimension so that the scorecard project has the necessary information about the organizational hierarchy.
If you want one scorecard for the entire organization and you do not want a separate scorecard for each level in the hierarchy, then you do not have to import a hierarchy. For this example, you will not import a hierarchy. Click the No radio button.

Click Next.

7. Click Finish on the Summary page.

Define a Range of Values for a Dashboard

After creating a scorecard, you can define a range of values for a dashboard. A range is a yardstick by which results are measured. It determines what color an indicator points to based on where the result falls in the range. Using a KPI template enables you to associate a dashboard display for the indicator. Each interval in the range is represented by a different color on the dial.

Complete the following steps:

1. Select Project ➤ Manage Ranges from the scorecard toolbar.
2. Click New Range.
3. Name the range.
4. Expand the Interval Definitions section and define the contiguous intervals that make up the range. For this scenario, the KPI to be displayed is a percentage. However, since the KPI is stored as a decimal value, specify the intervals as decimals.
5. Click **Apply**, Click **OK**, Click **Close**.

---

**Create a KPI for the Scorecard**

Next you define what value is to be displayed as the key performance indicator. Complete the following steps:

1. Click **New KPI** on the scorecard toolbar.
2. Name the KPI, add an optional description, and select a period. For this KPI the period is **Year**. Click **Next**.
3. Select the type of KPI. For this scenario, select **In current scorecard and all its children**. This enables you to have a scorecard for every level of the organization. Remember that in creating the scorecard, you imported a dimension to be converted to a scorecard hierarchy so that the scorecard is aware of the organizational structure. Click **Next**.
4. Choose the actual value to be displayed as the KPI. The actual value of a KPI is its real or current value. Actual values can be manually created or edited, provided by a single measure, or calculated using mathematical formulas.

   For this scenario, select an existing measure by doing the following:
   
   a. Select **An existing measure** and click **Select Measure**.
   
   b. From the **Category** drop-down list, select a category, such as **All**. Click **Go**.
   
   c. Select a metrics table from the **Metrics table** drop-down list. If you imported a hierarchy, select the metric table that has been created using the same dimension hierarchy as the one that is imported by this scorecard. Click **Go**.
   
   d. Select the radio button for a measure you want to use.
   
   e. From the **Value** drop-down list, select a value to be displayed in the KPI. For more information about measures in SAS Human Capital Management, see **Appendix A1, “Metrics in SAS Human Capital Management,”** on page 121.
5. Choose the target value to compare the KPI value to. The procedure for choosing a target value is the same as the procedure for selecting an actual value.

SAS Human Capital Management is designed for target values to be provided by data from the Saratoga Institute and to allow you to compare actual data for your organization to data from a significant selection of other organizations. If you are using the Saratoga Institute data, change your Value field to something such as MEAN_VAL for the mean of the measure, or P10_VAL for the tenth percentile value.

For this scenario, skip selecting a target value.

Click OK. Click Next.

6. You can select a performance value to display in the scorecard.

For this scenario, skip selecting a performance value. Click Next.

7. Select the range to be applied to the value. For this scenario, select the range you defined earlier.

Click Next.

8. Click Finish.

View the Data

By default, the scorecard opens in tabular format.

1. Select a column to be displayed. For this scenario, select Actual.

2. Select a date.

3. Click Go. The number is displayed.
The data that is displayed is a percentage, but the number is stored as a decimal value. To display it as a percentage:

1. Click the Action button by the Actual column.
2. Select Format Column.
3. Select Percentage as the type of value.
4. Click Apply. Click OK.

If you chose earlier to associate a KPI with every child scorecard in the project, you can click on a different level in the hierarchy to see the KPI for that level.

---

**Link to a Document from a Scorecard**

You can associate your scorecard with a document so that when a user clicks on a number in the scorecard, the associated document opens. To associate a scorecard with a document:

1. Click the Tables button to switch to tabular view.
2. Click the Action button in the first column of the KPI table.
3. Select Edit Metric Attributes.
The Metric Values, Ranges, and Actions window opens.

4. Select an attribute. For this scenario, select **Actual**.

5. Select a time period. For this scenario, select **YR2001**.

6. Select the **Actual Value** check box. Select a computed value option.

7. Select the **Actual Text** check box, and enter text.

8. Select the **Actual Action** check box. Select **Open a Document**.

9. Browse to the document to be opened when a KPI in the scorecard is clicked, and select a predefined report.

10. Click **OK**.

Now, when a user clicks on a KPI number, the associated document opens.

---

**Link to a Scorecard from an Organization Analysis**

You can also associate a scorecard with an organization analysis so that clicking on the organization analysis opens the associated scorecard.

For instructions on associating a scorecard with an organization analysis, see “Organization Analysis” on page 49.

---

**Create a KPI Portlet**

Having created a KPI, it is convenient to create a KPI portlet that you can add to the portal (for example, on your Home page) so that you can view the KPI without having to open either SAS Human Capital Management or SAS Strategy Management.

To create a KPI portlet:

1. Select **Manage Strategy Management Scorecard Projects and Templates** from a portlet.

   *Note:* If your Favorites portlet does not have the **Manage Strategy Management Scorecard Projects and Templates** option, then choose **Edit Portlet ➔ Add ➔ Task** to add it.

2. Select a KPI project.

3. Click the **Add to Portlet** button 📊. The Add to Portlet window opens.
4. Name the portlet and select the page to which to add it (for example, on your Home Page). Click **OK**.

5. After the portlet has been added, you can click **Edit Portlet** to change its properties.
Overview of SAS for Workforce Planning & Budgeting

Planning and budgeting for salary and headcount is a complex process that benefits from the integration of functionality and data between SAS Human Capital Management (HCM) and SAS Financial Management (FM). With SAS for Workforce Planning & Budgeting, HCM data is made available to the SAS Financial Management budgeting workflow. During the budgeting process, line of business managers participate in the structured workflow, as shown in this simplified diagram:

*Figure 13.1  Budgeting Workflow*
In a data-entry form, users have access to data from SAS Human Capital Management tables. This data, which is displayed in additional tables (supplemental schedules), might include details such as salary, bonus, travel expenses, and evaluations for each employee.

**Note:** A supplemental schedule, like a data-entry form, displays only data that the user is authorized to view.

In bottom-up workflows, data from the supplemental schedules is rolled up to the data-entry form and stored in SAS Financial Management.

## Working with Supplemental Schedules

A data-entry form with supplemental schedules might resemble the following image, which shows only part of a form. At the top is the data-entry table, representing values that are stored in SAS Financial Management. Below it are parts of two supplemental schedules, representing SAS Human Capital Management values. For each supplemental schedule, a different slicer value has been selected.

<table>
<thead>
<tr>
<th>Analysis Dimension</th>
<th>ATLANTIL</th>
<th>DARIO</th>
<th>MIGUEL</th>
<th>MARTIN</th>
<th>RENEDO</th>
<th>SANTIAGO</th>
<th>WU</th>
<th>YAO</th>
</tr>
</thead>
<tbody>
<tr>
<td>marital status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

As a participant in the budgeting process, if you open a data-entry form in Microsoft Excel, you can use the standard features of the SAS Financial Management Add-In for Microsoft Excel. The following additional features are available as part of SAS for Workforce Planning & Budgeting. (Some features are available only with bottom-up workflows.)

- The form might contain one or more supplemental schedules that are associated with SAS Human Capital Management. Some values in a supplemental schedule might come from an HCM table and some values might be generated when you create a new position. Some columns might require you to type in a value.
- Within a supplemental schedule, you can create additional rows to represent new positions in the budgeting process. You can create multiple (identical) positions at a time. They need not represent actual employees.
- If there are additional management levels below yours, you can drill down to lower levels. As you click a manager's name in the data-entry table, the employee list in the supplemental schedule is replaced by a list of employees for that manager, so that you can review that manager's information in detail. However, when you drill down in a form, the cells are not writeable. You can update the cells only for your direct reports.
- If a supplemental schedule contains slicers, you can select a different slicer value and any measures that depend on the slicer will display values that correspond to the new selection. For example, if a slicer included members of the Account dimension, selecting a different account might cause values for that account to be displayed.
For SAS Human Capital Management, most measures are slicer-independent: their values do not change value when the slicer changes. (There are exceptions for new positions and for measures that are not based on the HCM tables.)

- When you finish entering data, you select **Save All Supplemental Data** from the SAS Solutions menu.

  For each of the FM accounts in the supplemental schedules, the totals are rolled up to the data-entry table, and the supplemental schedules are saved.

  **Note:** The standard HCM tables provide input data for the supplemental schedules, but are not updated themselves.

For more information about using supplemental schedules in a data-entry form, see the online Help for the SAS Financial Management Add-In for Microsoft Excel.
Introduction

SAS Human Capital Management provides an extensive collection of predefined measures that are designed to be used with data provided by the Saratoga Institute.

Note: An administrator must have set up the data to use with these measures by running a job that loads the metric tables. Having the measures does not imply that you have the data.

The measures are available in the following categories:

- Organizational Effectiveness
- Human Resources Structure
- Compensation
- Benefits
- Separations
- Staffing
- Training and Development
# Organizational Effectiveness

**Table A1.1 Organizational Effectiveness Measures**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue Factor - Total</td>
<td>Dollars of unit revenue generated per total FTE</td>
<td>Revenue / Total FTE</td>
</tr>
<tr>
<td>Revenue Factor - Workforce Employees</td>
<td>Dollars of unit revenue generated per workforce on payroll FTE</td>
<td>Revenue / Workforce on Payroll FTE</td>
</tr>
<tr>
<td>Revenue Factor - Regular Employees</td>
<td>Dollars of unit revenue generated per all regular FTE employees</td>
<td>Revenue / Regular FTE</td>
</tr>
<tr>
<td>Expense Factor - Total</td>
<td>Dollars of unit operating expense incurred per total FTE</td>
<td>Operating Expense / Total FTE</td>
</tr>
<tr>
<td>Expense Factor - Workforce Employees</td>
<td>Dollars of unit operating expense incurred per workforce on payroll FTE</td>
<td>Operating Expense / Workforce on Payroll FTE</td>
</tr>
<tr>
<td>Expense Factor - Regular Employees</td>
<td>Dollars of unit operating expense incurred per all regular FTE employees</td>
<td>Operating Expense / Regular FTE</td>
</tr>
<tr>
<td>Income Factor - Total</td>
<td>Dollars of unit profit generated per total FTE</td>
<td>(Revenue - Operating Expense) / Total FTE</td>
</tr>
<tr>
<td>Income Factor - Workforce Employees</td>
<td>Dollars of unit profit generated per workforce on payroll FTE</td>
<td>(Revenue - Operating Expense) / Workforce on Payroll FTE</td>
</tr>
<tr>
<td>Income Factor - Regular Employees</td>
<td>Dollars of unit profit generated per all regular FTE employees</td>
<td>(Revenue - Operating Expense) / Regular FTE</td>
</tr>
<tr>
<td>Human Capital Value Added</td>
<td>Dollars of adjusted profit added per total FTE</td>
<td>(Revenue - (Operating Expense - (Compensation Cost (Workforce on Payroll) + Benefit Cost EPTNW))) / Total FTE</td>
</tr>
<tr>
<td>Human Capital ROI</td>
<td>Dollars of adjusted profit per each dollar spent on employee compensation and benefits</td>
<td>(Revenue - (Operating Expense - (Compensation Cost (Workforce on Payroll) + Benefit Cost EPTNW))) / (Compensation Cost (Workforce on Payroll) + Benefit Cost EPTNW)</td>
</tr>
<tr>
<td>Human Economic Value Added</td>
<td>Dollars of true profit (after expenses, taxes and capital costs) generated per total FTE</td>
<td>Net Operating Profit After Tax - (Shareholder's Equity * 0.12) / Total FTE</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Outsourcing Expense Percent</td>
<td>Outsourcing costs as a percentage of total operating costs</td>
<td>Outsourcing Expense / Operating Expense</td>
</tr>
<tr>
<td>Management Ratio - Total</td>
<td>Average number of employees to each manager</td>
<td>Total Headcount / Management Headcount</td>
</tr>
<tr>
<td>Management Ratio - Regular Employees</td>
<td>Average number of regular employees to each manager</td>
<td>Regular Headcount / Management Headcount</td>
</tr>
<tr>
<td>Management Investment Factor - Total</td>
<td>Average dollars spent on managers per total FTE</td>
<td>Management Compensation Cost / Total FTE</td>
</tr>
<tr>
<td>Management Investment Factor - Regular Employees</td>
<td>Average dollars spent on managers per all regular FTE employees</td>
<td>Management Compensation Cost / Regular FTE</td>
</tr>
<tr>
<td>Average Tenure - Total</td>
<td>Average length of service of all active regular employees</td>
<td>Total Employee Tenure / Regular Employee Headcount</td>
</tr>
<tr>
<td>Average Tenure - Exempt</td>
<td>Average length of service of all active, exempt, regular employees</td>
<td>Exempt Employee Tenure / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Average Tenure - Nonexempt</td>
<td>Average length of service of all active, nonexempt, regular employees</td>
<td>Nonexempt Employee Tenure / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Headcount Percent - Contingent - Total</td>
<td>Contingent employees as a percentage of total headcount</td>
<td>Total Contingent Headcount / Total Headcount</td>
</tr>
<tr>
<td>Headcount Percent - Contingent - Regular Employees</td>
<td>Contingent employees as a percentage of regular employee headcount</td>
<td>Total Contingent Headcount / Regular Employee Headcount</td>
</tr>
<tr>
<td>Headcount Percent - Contingent - On Payroll</td>
<td>Contingent on-payroll employees as a percentage of total headcount</td>
<td>Contingent On Payroll Headcount / Total Headcount</td>
</tr>
<tr>
<td>Headcount Percent - Contingent - Off Payroll</td>
<td>Contingent off-payroll employees as a percentage of total headcount</td>
<td>Contingent Off Payroll Headcount / Total Headcount</td>
</tr>
<tr>
<td>FTE Percent - Contingent - On Payroll</td>
<td>Contingent on-payroll FTE as a percentage total FTE</td>
<td>Contingent On Payroll FTE / Total FTE</td>
</tr>
<tr>
<td>FTE Percent - Contingent - Off Payroll</td>
<td>Contingent off-payroll FTE as a percentage total FTE</td>
<td>Contingent Off Payroll FTE / Total FTE</td>
</tr>
<tr>
<td>FTE Percent - Management</td>
<td>Management FTE as a percentage total FTE</td>
<td>Management FTE / Total FTE</td>
</tr>
<tr>
<td>FTE Percent - Professionals</td>
<td>Professional FTE as a percentage total FTE</td>
<td>Professionals FTE / Total FTE</td>
</tr>
<tr>
<td>FTE Percent - Sales</td>
<td>Sales FTE as a percentage total FTE</td>
<td>Sales FTE / Total FTE</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>FTE Percent - Office &amp; Clerical</td>
<td>Office &amp; Clerical FTE as a percentage total FTE</td>
<td>Office &amp; Clerical FTE / Total FTE</td>
</tr>
<tr>
<td>FTE Percent - Operatives</td>
<td>Operatives FTE as a percentage total FTE</td>
<td>Operatives FTE / Total FTE</td>
</tr>
</tbody>
</table>

### Human Resources Structure

**Table A1.2 Human Resources Structure Measures**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Expense Percent</td>
<td>Internal and external HR expenses as a percentage of operating expense</td>
<td>HR Expense / Operating Expense</td>
</tr>
<tr>
<td>HR FTE Ratio - Total</td>
<td>Total number of FTE employees that each Human Resource FTE supports</td>
<td>Total FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR FTE Ratio - Regular Employees</td>
<td>All regular employees that each Human Resource FTE supports</td>
<td>Regular FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Exempt Percent - Total</td>
<td>Exempt HR FTE as a percentage of total HR FTE</td>
<td>HR Exempt FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Exempt Percent - Regular Employees</td>
<td>Exempt HR FTE as a percentage of regular HR FTE</td>
<td>HR Exempt FTE / Regular HR FTE</td>
</tr>
<tr>
<td>HR FTE Investment Factor - Total</td>
<td>Dollars spent on Human Resource functions per total FTE</td>
<td>HR Expense / Total FTE</td>
</tr>
<tr>
<td>HR FTE Investment Factor - Regular Employees</td>
<td>Dollars spent on Human Resource functions per regular FTE</td>
<td>HR Expense / Regular FTE</td>
</tr>
<tr>
<td>HR Headcount Investment Factor - Total</td>
<td>Dollars spent on Human Resource functions per headcount employee</td>
<td>HR Expense / Total Headcount</td>
</tr>
<tr>
<td>HR Headcount Investment Factor - Regular Employees</td>
<td>Dollars spent on Human Resource functions per regular employee headcount</td>
<td>HR Expense / Regular Employee Headcount</td>
</tr>
<tr>
<td>HR Outsourcing Percent</td>
<td>HR outsourcing expenses as a percentage of total HR expense</td>
<td>HR Outsourcing Cost / HR Expense</td>
</tr>
<tr>
<td>HR Consulting Percent</td>
<td>HR consulting services expenses as a percentage of HR expense</td>
<td>HR Consulting Cost / HR Expense</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Compensation Expense Percent</td>
<td>HR compensation costs as a percentage of total operating expenses</td>
<td>HR Compensation Cost / Operating Expense</td>
</tr>
<tr>
<td>HR Employee Cost Factor</td>
<td>Average compensation paid to regular HR FTE</td>
<td>HR Compensation Cost / Regular HR FTE</td>
</tr>
<tr>
<td>HR Total Employee Cost Factor</td>
<td>Average compensation paid to regular HR employees including benefit costs</td>
<td>HR Compensation Cost * (1 + Benefits Comp Percent / Compensation Cost (Workforce of Payroll)) / Regular HR FTE</td>
</tr>
<tr>
<td>HR Separation Rate - Total</td>
<td>HR employees who terminated as a percentage of total HR headcount</td>
<td>Total HR Separations / Total HR Headcount</td>
</tr>
<tr>
<td>HR Separation Rate - Exempt</td>
<td>HR exempt employees who terminated as a percentage of total HR headcount</td>
<td>Exempt HR Separations / Exempt HR Headcount</td>
</tr>
<tr>
<td>HR Separation Rate - Nonexempt</td>
<td>HR nonexempt employees who terminated as a percentage of total HR headcount</td>
<td>Nonexempt HR Separations / Nonexempt HR Headcount</td>
</tr>
<tr>
<td>HR Structure Breakdown - Administrative</td>
<td>HR FTE in Administrative functions as a percentage of total HR FTE</td>
<td>HR Administrative FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - Benefits</td>
<td>HR FTE in Benefit functions as a percentage of total HR FTE</td>
<td>HR Benefits FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - Compensation</td>
<td>HR FTE in Compensation functions as a percentage of total HR FTE</td>
<td>HR Compensation FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - Employee Relations</td>
<td>HR FTE in Employee Relations functions as a percentage of total HR FTE</td>
<td>HR Employee Relations FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - HRIS</td>
<td>HR FTE in HRIS functions as a percentage of total HR FTE</td>
<td>HR HRIS FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - HR Management</td>
<td>HR FTE in HR Management functions as a percentage of total HR FTE</td>
<td>HR Management FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - Legal</td>
<td>HR FTE in Legal functions as a percentage of total HR FTE</td>
<td>HR Legal FTE / Total HR FTE</td>
</tr>
<tr>
<td>HR Structure Breakdown - Staffing</td>
<td>HR FTE in Staffing functions as a percentage of total HR FTE</td>
<td>HR Staffing FTE / Total HR FTE</td>
</tr>
</tbody>
</table>
### Compensation

**Table A1.3  Compensation Measures**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Revenue Percent - Workforce Employees</td>
<td>Workforce on-payroll compensation cost as a percentage of revenue</td>
<td>Compensation Cost (Workforce on Payroll) / Revenue</td>
</tr>
<tr>
<td>Compensation Revenue Percent - Regular Employees</td>
<td>Regular employee compensation cost as a percentage of revenue</td>
<td>Compensation Cost (Regular Employees) / Revenue</td>
</tr>
<tr>
<td>Total Compensation Revenue Percent</td>
<td>Workforce on-payroll compensation and benefit cost, excluding payments for time not worked (EPTNW), as a percentage of revenue</td>
<td>(Compensation Cost (Workforce on Payroll) + Benefit Cost EPTNW) / Revenue</td>
</tr>
<tr>
<td>Total Labor Cost Revenue Percent</td>
<td>Total compensation and benefit costs, excluding payments for time not worked (EPTNW), as a percentage of revenue</td>
<td>(Compensation Cost (Total) + Benefit Cost EPTNW) / Revenue</td>
</tr>
<tr>
<td>Compensation Expense Percent - Workforce Employees</td>
<td>Workforce on-payroll compensation cost as a percentage of operating expense</td>
<td>Compensation Cost (Workforce on Payroll) / Operating Expense</td>
</tr>
<tr>
<td>Compensation Expense Percent - Regular Employees</td>
<td>Regular employee compensation cost as a percentage of operating expense</td>
<td>Compensation Cost (Regular Employees) / Operating Expense</td>
</tr>
<tr>
<td>Total Compensation Expense Percent</td>
<td>Workforce on-payroll compensation and benefit cost, excluding payments for time not worked (EPTNW), as a percentage of operating expense</td>
<td>(Compensation Cost (Workforce on Payroll) + Benefit Cost EPTNW) / Operating Expense</td>
</tr>
<tr>
<td>Total Labor Cost Expense Percent</td>
<td>Total compensation and benefit costs, excluding payments for time not worked (EPTNW) as a percentage of operating expense</td>
<td>(Compensation Cost (Total) + Benefit Cost EPTNW) / Operating Expense</td>
</tr>
<tr>
<td>Compensation Percent - Executive</td>
<td>Executive compensation cost as a percentage of workforce on payroll compensation cost</td>
<td>Compensation Cost (Executive) / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Compensation Percent - Staff</td>
<td>Staff compensation cost as a percentage of workforce on payroll compensation cost</td>
<td>Compensation Cost (Staff) / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Compensation Percent - Variable</td>
<td>Variable compensation cost as a percentage of workforce on-payroll compensation cost</td>
<td>Variable Compensation Cost / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Compensation Percent - Contingent - Total</td>
<td>Total contingent compensation cost as a percentage of workforce on-payroll compensation cost</td>
<td>Contingent Cost / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Compensation Percent - Contingent - On Payroll</td>
<td>Contingent on-payroll compensation cost as a percentage of workforce on-payroll compensation cost</td>
<td>Contingent On Payroll Cost / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Compensation Percent - Contingent - Off Payroll</td>
<td>Contingent off-payroll compensation cost as a percentage of workforce on-payroll compensation cost</td>
<td>Contingent Off Payroll Cost / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Contingent Cost Revenue Percent - Total</td>
<td>Costs of contingent workers as a percentage of revenue generated</td>
<td>Contingent Cost / Revenue</td>
</tr>
<tr>
<td>Contingent Cost Revenue Percent - On Payroll</td>
<td>Costs of contingent on-payroll workers as a percentage of revenue generated</td>
<td>Contingent On Payroll Cost / Revenue</td>
</tr>
<tr>
<td>Contingent Cost Revenue Percent - Off Payroll</td>
<td>Costs of contingent off-payroll workers as a percentage of revenue generated</td>
<td>Contingent Off Payroll Cost / Revenue</td>
</tr>
<tr>
<td>Contingent Cost Expense Percent - Total</td>
<td>Costs of contingent workers as a percentage of operating expenses</td>
<td>Contingent Cost / Operating Expense</td>
</tr>
<tr>
<td>Contingent Cost Expense Percent - On Payroll</td>
<td>Costs of on-payroll contingent on-payroll workers as a percentage of operating expenses</td>
<td>Contingent On Payroll Cost / Operating Expense</td>
</tr>
<tr>
<td>Contingent Cost Expense Percent - Off Payroll</td>
<td>Costs of contingent off-payroll workers as a percentage of operating expenses</td>
<td>Contingent Off Payroll Cost / Operating Expense</td>
</tr>
<tr>
<td>Employee Cost Factor - Regular Employees</td>
<td>Average compensation paid to each regular FTE employee</td>
<td>Compensation Cost (Regular Employee) / Regular Employee FTE</td>
</tr>
<tr>
<td>Employee Cost Factor - Workforce</td>
<td>Average compensation paid to each workforce on payroll FTE employee</td>
<td>Compensation Cost (Workforce on Payroll) / Workforce on Payroll FTE</td>
</tr>
<tr>
<td>Employee Cost Factor - Executive</td>
<td>Average compensation paid to executive level staff (vice-president level and above)</td>
<td>Compensation Cost (Executive) / Executive FTE</td>
</tr>
<tr>
<td>Employee Cost Factor - Manager</td>
<td>Average compensation paid to managers</td>
<td>Compensation Cost (Manager) / Manager FTE</td>
</tr>
<tr>
<td>Employee Cost Factor - Staff</td>
<td>Average compensation paid to individual contributor employees, not including executives, managers and contingents</td>
<td>Compensation Cost (Staff) / Staff FTE</td>
</tr>
</tbody>
</table>
### Total Employee Cost Factor
Average compensation and benefit costs, excluding payments for time not worked (EPTNW), per regular employee FTE

\[
\text{Formula} = \frac{\text{Compensation Cost (Regular Employee)} + \text{Benefits Cost (EPTNW)}}{\text{Regular Employee FTE}}
\]

### Total Labor Cost Factor
Average compensation and benefit costs, excluding payments for time not worked (EPTNW), per all FTE, including contingent off-payroll employees

\[
\text{Formula} = \frac{\text{Compensation Cost (Total)} + \text{Benefits Cost (EPTNW)}}{\text{Total FTE}}
\]

### Contingent Cost Factor - Total
Average dollars paid to each contingent worker

\[
\text{Formula} = \frac{\text{Contingent Cost}}{\text{Total Contingent FTE}}
\]

### Contingent Cost Factor - On Payroll
Average dollars paid to each contingent on-payroll worker

\[
\text{Formula} = \frac{\text{Contingent On Payroll Cost}}{\text{Contingent On Payroll FTE}}
\]

### Contingent Cost Factor - Off Payroll
Average dollars paid to each contingent off-payroll worker

\[
\text{Formula} = \frac{\text{Contingent Off Payroll Cost}}{\text{Contingent Off Payroll FTE}}
\]

## Benefits

### Table A1.4 Benefits Measures

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefit Revenue Percent</td>
<td>Employee benefit cost as a percentage of revenue</td>
<td>Benefit Cost / Revenue</td>
</tr>
<tr>
<td>Benefit Expense Percent</td>
<td>Employee benefit cost as a percentage of operating expense</td>
<td>Benefit Cost / Operating Expense</td>
</tr>
<tr>
<td>Benefit Compensation Percent - Total</td>
<td>Employee benefit cost as a percentage of workforce on-payroll compensation cost</td>
<td>Benefit Cost EPTNW / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Benefit Compensation Percent - Regular Employees</td>
<td>Employee benefit cost as a percentage of regular employee compensation cost</td>
<td>Benefit Cost EPTNW / Comp. Cost (Regular Employees)</td>
</tr>
<tr>
<td>Benefit Factor</td>
<td>Average cost of benefits per workforce on-payroll employee</td>
<td>Benefit Cost / Workforce on Payroll Headcount</td>
</tr>
<tr>
<td>Benefit Factor - Regular Employees</td>
<td>Average cost of benefits per regular employee headcount</td>
<td>Benefit Cost / Regular Employee Headcount</td>
</tr>
</tbody>
</table>
### Table A1.5 Separations Measures

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation Rate - Total</td>
<td>Total voluntary and involuntary terminations as a percentage of employee headcount</td>
<td>Total Separations / Regular Employee Headcount</td>
</tr>
<tr>
<td>Workers' Compensation Factor</td>
<td>Workers' compensation cost per workforce on-payroll employee</td>
<td>Workers' Compensation Cost / Workforce on Payroll Headcount</td>
</tr>
<tr>
<td>Workers' Compensation Factor - Regular Employees</td>
<td>Workers' compensation cost per covered regular employee</td>
<td>Workers' Compensation Cost / Regular Employee Headcount</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Legally Required Payments</td>
<td>Legally required payments as a percentage of total benefit cost</td>
<td>Legally Required Payments / Benefit Cost</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Retirement &amp; Savings Plan Payments</td>
<td>Retirement and savings plan payments as a percentage of total benefit cost</td>
<td>Retirement &amp; Savings Plan Payments / Benefit Cost</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Life Insurance &amp; Death Benefit Payments</td>
<td>Life insurance and death benefit payments as a percentage of total benefit cost</td>
<td>Life Insurance &amp; Death Benefit Payments / Benefit Cost</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Medical &amp; Medically Related Benefit Payments</td>
<td>Medical and medically related benefit cost as a percentage of total benefit cost</td>
<td>Medical &amp; Medically Related Benefit Payments / Benefit Cost</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Payments for Time Not Worked</td>
<td>Payments for time not worked as a percentage of total benefit cost</td>
<td>Payments for Time Not Worked / Benefit Cost</td>
</tr>
<tr>
<td>Benefit Cost Breakdown - Miscellaneous Benefit Payments</td>
<td>Miscellaneous benefit payments as a percentage of total benefit cost</td>
<td>Miscellaneous Benefit Payments / Benefit Cost</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Separation Rate - Exempt</td>
<td>Total voluntary and involuntary exempt terminations as a percentage of employee headcount</td>
<td>Total Exempt Separations / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Separation Rate - Nonexempt</td>
<td>Total voluntary and involuntary nonexempt terminations as a percentage of employee headcount</td>
<td>Total Nonexempt Separations / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Total</td>
<td>Voluntary terminations as a percentage of employee headcount</td>
<td>Total Voluntary Separations / Regular Employee Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Exempt</td>
<td>Voluntary exempt terminations as a percentage of employee headcount</td>
<td>Exempt Voluntary Separations / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Nonexempt</td>
<td>Voluntary nonexempt terminations as a percentage of employee headcount</td>
<td>Nonexempt Voluntary Separations / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Total</td>
<td>Involuntary terminations as a percentage of employee headcount</td>
<td>Total Involuntary Separations / Regular Employee Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Exempt</td>
<td>Involuntary exempt terminations as a percentage of employee headcount</td>
<td>Exempt Involuntary Separations / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Nonexempt</td>
<td>Involuntary nonexempt terminations as a percentage of employee headcount</td>
<td>Nonexempt Involuntary Separations / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year</td>
<td>Voluntary separations with less than one year of service as a percentage of total voluntary separations</td>
<td>Voluntary Separations - 0 to 1 Yr / Total Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Exempt</td>
<td>Voluntary exempt separations with less than one year of service as a percentage of exempt voluntary separations</td>
<td>Exempt Voluntary Separations - 0 to 1 Yr / Exempt Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Nonexempt</td>
<td>Voluntary nonexempt separations with less than one year of service as a percentage of nonexempt voluntary separations</td>
<td>Nonexempt Voluntary Separations - 0 to 1 Yr / Nonexempt Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years</td>
<td>Voluntary separations with one to three years of service as a percentage of total voluntary separations</td>
<td>Voluntary Separations - 1+ to 3 Yrs / Total Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Exempt</td>
<td>Voluntary exempt separations with one to three years of service as a percentage of exempt voluntary separations</td>
<td>Exempt Voluntary Separations - 1+ to 3 Yrs / Exempt Voluntary Separations</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Nonexempt</td>
<td>Voluntary nonexempt separations with one to three years of service as a percentage of nonexempt voluntary separations</td>
<td>Nonexempt Voluntary Separations - 1+ to 3 Yrs / Nonexempt Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years</td>
<td>Voluntary separations with three to five years of service as a percentage of total voluntary separations</td>
<td>Voluntary Separations - 3+ to 5 Yrs / Total Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Exempt</td>
<td>Voluntary exempt separations with three to five years of service as a percentage of exempt voluntary separations</td>
<td>Exempt Voluntary Separations - 3+ to 5 Yrs / Exempt Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Nonexempt</td>
<td>Voluntary nonexempt separations with three to five years of service as a percentage of nonexempt voluntary separations</td>
<td>Nonexempt Voluntary Separations - 3+ to 5 Yrs / Nonexempt Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years</td>
<td>Voluntary separations with five to ten years of service as a percentage of total voluntary separations</td>
<td>Voluntary Separations - 5+ to 10 Yrs / Total Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Exempt</td>
<td>Voluntary exempt separations with five to ten years of service as a percentage of exempt voluntary separations</td>
<td>Exempt Voluntary Separations - 5+ to 10 Yrs / Exempt Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Nonexempt</td>
<td>Voluntary nonexempt separations with five to ten years of service as a percentage of nonexempt voluntary separations</td>
<td>Nonexempt Voluntary Separations - 5+ to 10 Yrs / Nonexempt Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years</td>
<td>Voluntary separations with more than ten years of service as a percentage of total voluntary separations</td>
<td>Voluntary Separations - 10+ Yrs / Total Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Exempt</td>
<td>Voluntary exempt separations with more than ten years of service as a percentage of exempt voluntary separations</td>
<td>Exempt Voluntary Separations - 10+ Yrs / Exempt Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Nonexempt</td>
<td>Voluntary nonexempt separations with more than ten years of service as a percentage of nonexempt voluntary separations</td>
<td>Nonexempt Voluntary Separations - 10+ Yrs / Nonexempt Vol Separations</td>
</tr>
<tr>
<td>Separation Rate - Management</td>
<td>Total voluntary and involuntary management terminations as a percentage of management employee headcount</td>
<td>Total Management Separations / Management Headcount</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Separation Rate - Professionals</td>
<td>Total voluntary and involuntary professional terminations as a percentage of professional employee headcount</td>
<td>Total Professionals Separations / Professionals Headcount</td>
</tr>
<tr>
<td>Separation Rate - Sales</td>
<td>Total voluntary and involuntary sales terminations as a percentage of sales employee headcount</td>
<td>Total Sales Separations / Sales Headcount</td>
</tr>
<tr>
<td>Separation Rate - Office &amp; Clerical</td>
<td>Total voluntary and involuntary office &amp; clerical terminations as a percentage of office &amp; clerical employee headcount</td>
<td>Total Office &amp; Clerical Separations / Office &amp; Clerical Headcount</td>
</tr>
<tr>
<td>Separation Rate - Operatives</td>
<td>Total voluntary and involuntary operative terminations as a percentage of operative employee headcount</td>
<td>Total Operatives Separations / Operatives Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Management</td>
<td>Voluntary management terminations as a percentage of management employee headcount</td>
<td>Management Voluntary Separations / Management Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Professionals</td>
<td>Voluntary professional terminations as a percentage of professional employee headcount</td>
<td>Professionals Voluntary Separations / Professionals Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Sales</td>
<td>Voluntary sales terminations as a percentage of sales employee headcount</td>
<td>Sales Voluntary Separations / Sales Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations as a percentage of office &amp; clerical employee headcount</td>
<td>Office &amp; Clerical Voluntary Separations / Office &amp; Clerical Headcount</td>
</tr>
<tr>
<td>Voluntary Separation Rate - Operatives</td>
<td>Voluntary operative terminations as a percentage of operative employee headcount</td>
<td>Operatives Voluntary Separations / Operatives Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Management</td>
<td>Involuntary management terminations as a percentage of management employee headcount</td>
<td>Management Involuntary Separations / Management Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Professionals</td>
<td>Involuntary professional terminations as a percentage of professional employee headcount</td>
<td>Professionals Involuntary Separations / Professionals Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Sales</td>
<td>Involuntary sales terminations as a percentage of sales employee headcount</td>
<td>Sales Involuntary Separations / Sales Headcount</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Office &amp; Clerical</td>
<td>Involuntary office &amp; clerical terminations as a percentage of office &amp; clerical employee headcount</td>
<td>Office &amp; Clerical Involuntary Separations / Office &amp; Clerical Headcount</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Involuntary Separation Rate - Operatives</td>
<td>Involuntary operative terminations as a percentage of operative employee headcount</td>
<td>Operatives Involuntary Separations / Operatives Headcount</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Management</td>
<td>Voluntary management terminations with less than one year of service as a percentage of management voluntary separations</td>
<td>Management Vol Separations - 0 to 1 Yr / Management Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Management</td>
<td>Voluntary management terminations with one to three years of service as a percentage of management voluntary separations</td>
<td>Management Vol Separations - 1+ to 3 Yrs / Management Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Management</td>
<td>Voluntary management terminations with three to five years of service as a percentage of management voluntary separations</td>
<td>Management Vol Separations - 3+ to 5 Yrs / Management Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Management</td>
<td>Voluntary management terminations with five to ten years of service as a percentage of management voluntary separations</td>
<td>Management Vol Separations - 5+ to 10 Yrs / Management Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Management</td>
<td>Voluntary management terminations with more than ten years of service as a percentage of management voluntary separations</td>
<td>Management Vol Separations - 10+ Yrs / Management Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Professionals</td>
<td>Voluntary professionals terminations with less than one year of service as a percentage of professional voluntary separations</td>
<td>Professionals Vol Separations - 0 to 1 Yr / Professionals Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Professionals</td>
<td>Voluntary professionals terminations with one to three years of service as a percentage of professional voluntary separations</td>
<td>Professionals Vol Separations - 1+ to 3 Yrs / Professionals Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Professionals</td>
<td>Voluntary professionals terminations with three to five years of service as a percentage of professional voluntary separations</td>
<td>Professionals Vol Separations - 3+ to 5 Yrs / Professionals Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Professionals</td>
<td>Voluntary professionals terminations with five to ten years of service as a percentage of professional voluntary separations</td>
<td>Professionals Vol Separations - 5+ to 10 Yrs / Professionals Vol Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Professionals</td>
<td>Voluntary professionals terminations with more than years of service as a percentage of professional voluntary separations</td>
<td>Professionals Vol Separations - 10+ Yrs / Professionals Vol Separations</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Sales</td>
<td>Voluntary sales terminations with less than one year of service as a percentage of sales voluntary separations</td>
<td>Sales Voluntary Separations - 0 to 1 Yr / Sales Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Sales</td>
<td>Voluntary sales terminations with one to three years of service as a percentage of sales voluntary separations</td>
<td>Sales Voluntary Separations - 1+ to 3 Yrs / Sales Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Sales</td>
<td>Voluntary sales terminations with three to five years of service as a percentage of sales voluntary separations</td>
<td>Sales Voluntary Separations - 3+ to 5 Yrs / Sales Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Sales</td>
<td>Voluntary sales terminations with five to ten years of service as a percentage of sales voluntary separations</td>
<td>Sales Voluntary Separations - 5+ to 10 Yrs / Sales Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Sales</td>
<td>Voluntary sales terminations with more than ten years of service as a percentage of sales voluntary separations</td>
<td>Sales Voluntary Separations - 10+ Yrs / Sales Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations with less than one year of service as a percentage of office &amp; clerical voluntary separations</td>
<td>Office &amp; Clerical Voluntary Separations - 0 to 1 Yr / Office &amp; Clerical Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 1+ to 3 Years - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations with one to three years of service as a percentage of office &amp; clerical voluntary separations</td>
<td>Office &amp; Clerical Voluntary Separations - 1+ to 3 Yrs / Office &amp; Clerical Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 3+ to 5 Years - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations with three to five years of service as a percentage of office &amp; clerical voluntary separations</td>
<td>Office &amp; Clerical Voluntary Separations - 3+ to 5 Yrs / Office &amp; Clerical Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 5+ to 10 Years - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations with five to ten years of service as a percentage of office &amp; clerical voluntary separations</td>
<td>Office &amp; Clerical Voluntary Separations - 5+ to 10 Yrs / Office &amp; Clerical Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 10+ Years - Office &amp; Clerical</td>
<td>Voluntary office &amp; clerical terminations with more than ten years of service as a percentage of office &amp; clerical voluntary separations</td>
<td>Office &amp; Clerical Voluntary Separations - 10+ Yrs / Office &amp; Clerical Voluntary Separations</td>
</tr>
<tr>
<td>Voluntary Separations by LOS - 0 to 1 Year - Operatives</td>
<td>Voluntary operatives' terminations with less than one year of service as a percentage of operatives voluntary separations</td>
<td>Operatives Vol Separations - 0 to 1 Yr / Operatives Vol Separations</td>
</tr>
</tbody>
</table>
### Table A1.6 Staffing Measures

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accession Rate - Total</td>
<td>All hires as a percentage of regular employee headcount</td>
<td>Total Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Accession Rate - Exempt</td>
<td>All exempt hires as a percentage of exempt regular employee headcount</td>
<td>Exempt Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Accession Rate - Nonexempt</td>
<td>All nonexempt hires as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Accession Rate - External - Total</td>
<td>External new hire employees as a percentage of regular employee headcount</td>
<td>External Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Accession Rate - External - Exempt</td>
<td>External exempt new hire employees as a percentage of exempt regular employee headcount</td>
<td>Exempt External Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Accession Rate - External - Nonexempt</td>
<td>External nonexempt new hire employees as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt External Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Accession Rate - Internal - Total</td>
<td>Internal new hire employees as a percentage of regular employee headcount</td>
<td>Internal Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Accession Rate - Internal - Exempt</td>
<td>Internal exempt new hire employees as a percentage of exempt regular employee headcount</td>
<td>Exempt Internal Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Accession Rate - Internal - Nonexempt</td>
<td>Internal nonexempt new hire employees as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt Internal Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Accession Rate - College - Total</td>
<td>All college hires as a percentage of regular employee headcount</td>
<td>College Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Add Rate - Total</td>
<td>Employees hired to fill new positions as a percentage of regular employee headcount</td>
<td>Total Add Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Add Rate - Exempt</td>
<td>Exempt employees hired to fill new positions as a percentage of exempt regular headcount</td>
<td>Exempt Add Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Add Rate - Nonexempt</td>
<td>Nonexempt employees hired to fill new positions as a percentage of nonexempt regular headcount</td>
<td>Nonexempt Add Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Add Rate - External - Total</td>
<td>External employees hired to new positions as a percentage of regular employee headcount</td>
<td>External Add Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Add Rate - External - Exempt</td>
<td>External exempt employees hired to new positions as a percentage of exempt regular employee headcount</td>
<td>Exempt External Add Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Add Rate - External - Nonexempt</td>
<td>External nonexempt employees hired to new positions as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt External Add Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Add Rate - Internal - Total</td>
<td>Internal employees hired to new positions as a percentage of regular employee headcount</td>
<td>Internal Add Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Add Rate - Internal - Exempt</td>
<td>Internal exempt employees hired to new positions as a percentage of exempt regular employee headcount</td>
<td>Exempt Internal Add Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Add Rate - Internal - Nonexempt</td>
<td>Internal nonexempt employees hired to new positions as a percentage of nonexempt regular employee headcount</td>
<td>Add Rate - Internal - Nonexempt</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replacement Rate - Total</td>
<td>Employees hired to fill existing positions as a percentage of regular employee headcount</td>
<td>Total Replacement Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Replacement Rate - Exempt</td>
<td>Exempt employees hired to fill existing positions as a percentage of exempt regular employee headcount</td>
<td>Exempt Replacement Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Replacement Rate - Nonexempt</td>
<td>Nonexempt employees hired to fill existing positions as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt Replacement Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Replacement Rate - External - Total</td>
<td>External employees hired to fill existing positions as a percentage of regular employee headcount</td>
<td>External Replacement Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Replacement Rate - External - Exempt</td>
<td>External exempt employees hired to fill existing positions as a percentage of exempt regular employee headcount</td>
<td>Exempt External Replacement Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Replacement Rate - External - Nonexempt</td>
<td>External nonexempt employees hired to fill existing positions as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt External Replacement Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Replacement Rate - Internal - Total</td>
<td>Internal employees hired to fill existing positions as a percentage of regular employee headcount</td>
<td>Internal Replacement Hires / Regular Employee Headcount</td>
</tr>
<tr>
<td>Replacement Rate - Internal - Exempt</td>
<td>Internal exempt employees hired to fill existing positions as a percentage of exempt regular employee headcount</td>
<td>Exempt Internal Replacement Hires / Exempt Regular Headcount</td>
</tr>
<tr>
<td>Replacement Rate - Internal - Nonexempt</td>
<td>Internal nonexempt employees hired to fill existing positions as a percentage of nonexempt regular employee headcount</td>
<td>Nonexempt Internal Replacement Hires / Nonexempt Regular Headcount</td>
</tr>
<tr>
<td>Career Path Ratio - Total</td>
<td>Promotions as a percentage of all movement within the organization</td>
<td>Total Promotions / (Total Promotions + Total Transfers)</td>
</tr>
<tr>
<td>Career Path Ratio - Exempt</td>
<td>Exempt promotions as a percentage of exempt movement within the organization</td>
<td>Exempt Promotions / (Exempt Promotions + Exempt Transfers)</td>
</tr>
<tr>
<td>Career Path Ratio - Nonexempt</td>
<td>Nonexempt promotions as a percentage of nonexempt movement within the organization</td>
<td>Nonexempt Promotions / (Nonexempt Promotions + Nonexempt Transfers)</td>
</tr>
<tr>
<td>Cost per Hire - Total</td>
<td>Average dollars spent on hiring costs per employee hired</td>
<td>(Total Hiring Costs * 1.1 Factor) / Total Hires</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Per Hire - Exempt</td>
<td>Average dollars spent on exempt employee hiring costs per exempt employee hired</td>
<td>(Exempt Hiring Costs * 1.1 Factor) / Exempt Hires</td>
</tr>
<tr>
<td>Cost Per Hire - Nonexempt</td>
<td>Average dollars spent on nonexempt employee hiring costs per nonexempt employee hired</td>
<td>(Nonexempt Hiring Costs * 1.1 Factor) / Nonexempt Hires</td>
</tr>
<tr>
<td>Cost Per Hire - External - Total</td>
<td>Average dollars spent on external employee hiring costs per external employee hired</td>
<td>(External Hiring Costs * 1.1 Factor) / External Hires</td>
</tr>
<tr>
<td>Cost Per Hire - External - Exempt</td>
<td>Average dollars spent on exempt external employee hiring costs per exempt external employee hired</td>
<td>(Exempt External Hiring Costs * 1.1 Factor) / Exempt External Hires</td>
</tr>
<tr>
<td>Cost Per Hire - External - Nonexempt</td>
<td>Average dollars spent on nonexempt external employee hiring costs per nonexempt external employee hired</td>
<td>(Nonexempt External Hiring Costs * 1.1 Factor) / Nonexempt External Hires</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Total</td>
<td>Average dollars spent on internal employee hiring costs per internal employee hired</td>
<td>(Internal Hiring Costs * 1.1 Factor) / Internal Hires</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Exempt</td>
<td>Average dollars spent on exempt internal employee hiring costs per exempt internal employee hired</td>
<td>(Exempt Internal Hiring Costs * 1.1 Factor) / Exempt Internal Hires</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Nonexempt</td>
<td>Average dollars spent on nonexempt internal employee hiring costs per nonexempt internal employee hired</td>
<td>(Nonexempt Internal Hiring Costs * 1.1 Factor) / Nonexempt Internal Hires</td>
</tr>
<tr>
<td>Cost Per Hire - College - Total</td>
<td>Average dollars spent on college employee hiring costs per college employee hired</td>
<td>(College Hiring Costs * 1.1 Factor) / College Hires</td>
</tr>
<tr>
<td>Cost Per Hire - Advertising</td>
<td>Advertising costs as a percentage of total new hire cost</td>
<td>Cost Per Hire - Advertising</td>
</tr>
<tr>
<td>Cost Per Hire - Agency</td>
<td>Agency costs as a percentage of total new hire cost</td>
<td>Agency Hiring Costs / Total Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Referral Bonuses</td>
<td>Referral bonuses costs as a percentage of total new hire cost</td>
<td>Referral Bonuses Hiring Costs / Total Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Travel</td>
<td>Travel costs as a percentage of total new hire cost</td>
<td>Travel Hiring Costs / Total Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Relocation</td>
<td>Relocation costs as a percentage of total new hire cost</td>
<td>Relocation Hiring Costs / Total Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Recruiter</td>
<td>HR recruiter costs as a percentage of total new hire cost</td>
<td>Recruiter Hiring Costs / Total Hiring Costs</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Per Hire - External - Advertising</td>
<td>External advertising costs as a percentage of total external new hire cost</td>
<td>External Advertising Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - External - Agency</td>
<td>External agency costs as a percentage of total external new hire cost</td>
<td>External Agency Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - External - Referral Bonuses</td>
<td>External referral bonuses costs as a percentage of total external new hire cost</td>
<td>External Referral Bonuses Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - External - Travel</td>
<td>External travel costs as a percentage of total external new hire cost</td>
<td>External Travel Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - External - Relocation</td>
<td>External relocation costs as a percentage of total external new hire cost</td>
<td>External Relocation Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - External - Recruiter</td>
<td>External HR recruiter costs as a percentage of total external new hire cost</td>
<td>External Recruiter Hiring Costs / External Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Advertising</td>
<td>Internal advertising costs as a percentage of total internal new hire cost</td>
<td>Internal Advertising Hiring Costs / Internal Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Travel</td>
<td>Internal travel costs as a percentage of total internal new hire cost</td>
<td>Internal Travel Hiring Costs / Internal Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Relocation</td>
<td>Internal relocation costs as a percentage of total internal new hire cost</td>
<td>Internal Relocation Hiring Costs / Internal Hiring Costs</td>
</tr>
<tr>
<td>Cost Per Hire - Internal - Recruiter</td>
<td>Internal HR recruiter costs as a percentage of total internal new hire cost</td>
<td>Internal Recruiter Hiring Costs / Internal Hiring Costs</td>
</tr>
<tr>
<td>Time to Fill - Total</td>
<td>Average number of calendar days from requisition date to offer acceptance per hire</td>
<td>Total Days to Fill / Total Hires</td>
</tr>
<tr>
<td>Time to Fill - Exempt</td>
<td>Average number of calendar days from requisition date to offer acceptance per exempt hire</td>
<td>Exempt Days to Fill / Exempt Hires</td>
</tr>
<tr>
<td>Time to Fill - Nonexempt</td>
<td>Average number of calendar days from requisition date to offer acceptance per nonexempt hire</td>
<td>Nonexempt Days to Fill / Nonexempt Hires</td>
</tr>
<tr>
<td>Time to Fill - External - Total</td>
<td>Number of calendar days from requisition date to offer acceptance per new external hire</td>
<td>External Days to Fill / External Hires</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Time to Fill - External - Exempt</td>
<td>Number of calendar days from requisition date to offer acceptance per new external exempt hire</td>
<td>Exempt External Days to Fill / Exempt External Hires</td>
</tr>
<tr>
<td>Time to Fill - External - Nonexempt</td>
<td>Number of calendar days from requisition date to offer acceptance per new external nonexempt hire</td>
<td>Nonexempt External Days to Fill / Nonexempt External Hires</td>
</tr>
<tr>
<td>Time to Fill - Internal - Total</td>
<td>Number of calendar days from requisition date to offer acceptance per new internal hire</td>
<td>Internal Days to Fill / Internal Hires</td>
</tr>
<tr>
<td>Time to Fill - Internal - Exempt</td>
<td>Number of calendar days from requisition date to offer acceptance per new internal exempt hire</td>
<td>Exempt Internal Days to Fill / Exempt Internal Hires</td>
</tr>
<tr>
<td>Time to Fill - Internal - Nonexempt</td>
<td>Number of calendar days from requisition date to offer acceptance per new internal nonexempt hire</td>
<td>Nonexempt Internal Days to Fill / Nonexempt Internal Hires</td>
</tr>
<tr>
<td>Time to Start - Total</td>
<td>Average number of calendar days from requisition date to employee start date per hire</td>
<td>Total Days to Start / Total Hires</td>
</tr>
<tr>
<td>Time to Start - Exempt</td>
<td>Average number of calendar days from requisition date to employee start date per exempt hire</td>
<td>Exempt Days to Start / Exempt Hires</td>
</tr>
<tr>
<td>Time to Start - Nonexempt</td>
<td>Average number of calendar days from requisition date to employee start date per nonexempt hire</td>
<td>Nonexempt Days to Start / Nonexempt Hires</td>
</tr>
<tr>
<td>Time to Start - External - Total</td>
<td>Average number of calendar days from requisition date to employee start date per new external hire</td>
<td>External Days to Start / External Hires</td>
</tr>
<tr>
<td>Time to Start - External - Exempt</td>
<td>Average number of calendar days from requisition date to employee start date per new external exempt hire</td>
<td>Exempt External Days to Start / Exempt External Hires</td>
</tr>
<tr>
<td>Time to Start - External - Nonexempt</td>
<td>Average number of calendar days from requisition date to employee start date per new external nonexempt hire</td>
<td>Nonexempt External Days to Start / Nonexempt External Hires</td>
</tr>
<tr>
<td>Time to Start - Internal - Total</td>
<td>Average number of calendar days from requisition date to employee start date per new internal hire</td>
<td>Internal Days to Start / Internal Hires</td>
</tr>
<tr>
<td>Time to Start - Internal - Exempt</td>
<td>Average number of calendar days from requisition date to employee start date per new internal exempt hire</td>
<td>Exempt Internal Days to Start / Exempt Internal Hires</td>
</tr>
</tbody>
</table>
### Time to Start - Internal - Nonexempt
Average number of calendar days from requisition date to employee start date per new internal nonexempt hire
Nonexempt Internal Days to Start / Nonexempt Internal Hires

### Offer Acceptance Rate
Offers accepted as a percentage of offers made
Total Offers Accepted / Total Offers Extended

### Offer Acceptance Rate - External
External new hire offers accepted as a percentage of external new hire offers made
External Offers Accepted / External Offers Extended

### Offer Acceptance Rate - College
New college hire offers accepted as a percentage of new college hire offers made
College Offers Accepted / College Offers Extended

### Sign-On Bonus Percent
New hires receiving a sign-on bonus as a percentage of total new external and college hires
Total Hires Receiving Sign-On Bonuses / (External Hires + College Hires)

### Sign-On Bonus Percent - Executive
New executive hires receiving a sign-on bonus as a percentage of total executive new hires
Executive Hires Receiving Sign-On Bonuses / Executive Hires

### Sign-On Bonus Percent - Manager
New manager hires receiving a sign-on bonus as a percentage of total manager new hires
Manager Hires Receiving Sign-On Bonuses / Manager Hires

### Sign-On Bonus Factor
Average sign-on bonus amount for each new hire who received sign-on bonus
Total Sign-On Bonus Cost / Total Hires Receiving Sign-On Bonuses

### Sign-On Bonus Factor - Executive
Average sign-on bonus amount for each new executive hire who received sign-on bonus
Executive Sign-On Bonus Cost / Executive Hires Receiving Sign-On Bonuses

### Sign-On Bonus Factor - Manager
Average sign-on bonus amount for each new manager hire who received sign-on bonus
Manager Sign-On Bonus Cost / Manager Hires Receiving Sign-On Bonuses

---

**Training and Development**

**Table A1.7  Training and Development Measures**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees Trained Percent</td>
<td>Employees receiving training as a percentage of total headcount</td>
<td>Workforce Trained / Total Headcount</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Employees Trained Percent - Regular Employees</td>
<td>Employees receiving training as a percentage of regular employee headcount</td>
<td>Workforce Trained / Regular Employee Headcount</td>
</tr>
<tr>
<td>Training Cost Factor - Total</td>
<td>Dollars spent on training for each employee who received training</td>
<td>Total Training Cost / Workforce Trained</td>
</tr>
<tr>
<td>Training Cost Factor - Excluding Trainee Pay &amp; Benefits</td>
<td>Average dollars spent on training for each employee who received training excluding Trainee Pay &amp; Benefits</td>
<td>Total Training Cost (ETPB) / Workforce Trained</td>
</tr>
<tr>
<td>Training Cost Percent - Total</td>
<td>Total training costs as a percentage of operating expense</td>
<td>Total Training Cost / Operating Expense</td>
</tr>
<tr>
<td>Training Cost Percent - Excluding Trainee Pay &amp; Benefits - Total</td>
<td>Total training costs as a percentage of operating expense excluding Trainee Pay &amp; Benefits (ETPB)</td>
<td>Total Training Cost (ETPB) / Operating Expense</td>
</tr>
<tr>
<td>Training Cost Percent - Excluding Trainee Pay &amp; Benefits - External</td>
<td>External training cost as a percentage of total training cost excluding Trainee Pay &amp; Benefits</td>
<td>External Training Cost (ETPB) / Total Training Cost (ETPB)</td>
</tr>
<tr>
<td>Training Cost Percent - Excluding Trainee Pay &amp; Benefits - Internal</td>
<td>Internal training cost as a percentage of total training cost excluding Trainee Pay &amp; Benefits</td>
<td>Internal Training Cost (ETPB) / Total Training Cost (ETPB)</td>
</tr>
<tr>
<td>Training Cost HR Expense % - Total</td>
<td>Training cost as a percentage of HR expense</td>
<td>Total Training Cost / HR Expense</td>
</tr>
<tr>
<td>Training Cost HR Expense Percent - Excluding Trainee Pay &amp; Benefits</td>
<td>Training cost as a percentage of HR expense excluding Trainee Pay &amp; Benefits</td>
<td>Total Training Cost (ETPB) / HR Expense</td>
</tr>
<tr>
<td>Training Compensation % - Total</td>
<td>Training cost as a percentage of workforce on payroll compensation cost</td>
<td>Total Training Cost / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Training Compensation Percent - Regular Employees</td>
<td>Training cost as a percentage of regular employee compensation cost</td>
<td>Total Training Cost / Comp. Cost (Regular Employees)</td>
</tr>
<tr>
<td>Training Compensation Percent - Excluding Trainee Pay &amp; Benefits (ETPB)</td>
<td>Training cost, excluding Trainee Pay &amp; Benefits (ETPB) as a percentage of workforce on payroll compensation cost</td>
<td>Total Training Cost (ETPB) / Compensation Cost (Workforce on Payroll)</td>
</tr>
<tr>
<td>Training Compensation Percent - Regular Employees (ETPB)</td>
<td>Training cost, excluding trainee pay and benefits (ETPB) as a percentage of regular employee compensation cost</td>
<td>Total Training Cost ETPB / Comp. Cost (Regular Employees)</td>
</tr>
<tr>
<td>Training Headcount Investment Factor</td>
<td>Average dollars spent on training per headcount employee</td>
<td>Total Training Cost / Total Headcount</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Training Headcount Investment Factor -</td>
<td>Average dollars spent on training per regular employee headcount</td>
<td>Total Training Cost / Regular Employee Headcount</td>
</tr>
<tr>
<td>Regular Employees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Training Headcount Investment Factor -</td>
<td>Average dollars spent on training excluding trainee pay and benefits (ETPB)</td>
<td>Total Training Cost (ETPB) / Total Headcount</td>
</tr>
<tr>
<td>Excluding Trainee Pay &amp; Benefits</td>
<td>per headcount</td>
<td></td>
</tr>
<tr>
<td>Training Headcount Investment Factor -</td>
<td>Average dollars spent on training excluding trainee pay and benefits (ETPB)</td>
<td>Total Training Cost (ETPB) / Regular Employee</td>
</tr>
<tr>
<td>Regular Employees (ETPB)</td>
<td>per regular employee headcount</td>
<td>Headcount</td>
</tr>
<tr>
<td>Headcount Training Factor - Total</td>
<td>Average number of hours of training per headcount employee</td>
<td>Total Training Hours / Total Headcount</td>
</tr>
<tr>
<td>Headcount Training Factor - Regular</td>
<td>Average number of hours of training per regular employee headcount</td>
<td>Total Training Hours / Regular Employee Headcount</td>
</tr>
<tr>
<td>Employees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTE Training Factor - Total</td>
<td>Average number of hours of training per FTE employee</td>
<td>Total Training Hours / Total FTE</td>
</tr>
<tr>
<td>FTE Training Factor - Regular Employees</td>
<td>Average number of hours of training per regular FTE</td>
<td>Total Training Hours / Regular FTE</td>
</tr>
<tr>
<td>Training FTE Investment Factor - Total</td>
<td>Average dollar amount spent on training per FTE employee</td>
<td>Total Training Cost / Total FTE</td>
</tr>
<tr>
<td>Training FTE Investment Factor - Regular</td>
<td>Average dollar amount spent on exempt training per exempt FTE employee</td>
<td>Total Exempt Training Cost / Exempt FTE</td>
</tr>
<tr>
<td>Employees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Training FTE Investment Factor - Total -</td>
<td>Average dollar amount spent on nonexempt training per nonexempt FTE</td>
<td>Total Nonexempt Training Cost / Nonexempt FTE</td>
</tr>
<tr>
<td>Exempt</td>
<td>employee</td>
<td></td>
</tr>
<tr>
<td>Training FTE Investment Factor - Total -</td>
<td>Average dollar amount spent on training, excluding Trainee Pay &amp; Benefits</td>
<td>Total Training Cost (ETPB) / Total FTE</td>
</tr>
<tr>
<td>Excl. Trainee Pay &amp; Benefits - Total</td>
<td>(ETPB), per FTE employee</td>
<td></td>
</tr>
<tr>
<td>Training FTE Investment Factor - ETPB -</td>
<td>Average dollar amount spent on training, excluding Trainee Pay &amp; Benefits</td>
<td>Total Employee Training Cost (ETPB) / Regular FTE</td>
</tr>
<tr>
<td>Regular Employees</td>
<td>(ETPB), per regular FTE employee</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Training FTE Investment Factor - ETPB - Exempt</td>
<td>Average dollar amount spent on exempt training, excluding Trainee Pay &amp; Benefits (ETPB), per exempt FTE employee</td>
<td>Exempt Training Cost (ETPB) / Exempt FTE</td>
</tr>
<tr>
<td>Training FTE Investment Factor - ETPB - Nonexempt</td>
<td>Average dollar amount spent on nonexempt training, excluding Trainee Pay &amp; Benefits (ETPB), per nonexempt FTE employee</td>
<td>Nonexempt Training Cost (ETPB) / Nonexempt FTE</td>
</tr>
<tr>
<td>Training Staff Ratio - Total</td>
<td>Average number of FTE employees supported by each training staff FTE</td>
<td>Total FTE / Training Staff FTE</td>
</tr>
<tr>
<td>Training Staff Ratio - Regular Employees</td>
<td>Average number of regular FTE employees supported by each training staff FTE</td>
<td>Regular FTE / Training Staff FTE</td>
</tr>
<tr>
<td>Training Cost Per Hour - Total</td>
<td>Average dollars spent on training per hour of training provided</td>
<td>Total Training Cost / Total Training Hours</td>
</tr>
<tr>
<td>Training Cost Per Hour - Excluding Trainee Pay &amp; Benefits</td>
<td>Average dollars spent on training, excluding Trainee Pay and Benefits (ETPB) per hour of training provided</td>
<td>Total Training Cost (ETPB) / Total Training Hours</td>
</tr>
<tr>
<td>Training Hours Percent - Internal Staff</td>
<td>Internal training hours as a percentage of total training hours</td>
<td>Internal Staff Training Hours / Total Training Hours</td>
</tr>
<tr>
<td>Training Hours Percent - External Staff</td>
<td>External training hours as a percentage of total training hours</td>
<td>External Staff Training Hours / Total Training Hours</td>
</tr>
</tbody>
</table>
# Index

## A
- advanced searches 9
- analysis view
  - organization analysis 51

## B
- bar charts 19
- bar-line charts 20
- budgeting 117

## C
- case-sensitive searches 10
- columns
  - searching on default columns 8
- content
  - adding to portlet 29
  - deleting 30
  - importing 27
  - managing in workspace 27
  - moving 29
  - searching for 27
  - sharing via e-mail 30
- cubes
  - information maps for default 107
  - list of default cubes 107
  - opening in SAS Web Report Studio 107

## D
- data-entry forms 118
- display options
  - for organization analysis 55
- document properties 30

## E
- e-mail
  - sharing content via 30
- Employee Browser 35
- changing the hierarchy 42
- customizing employee profiles 47
- exporting employee data 41
- finding people 40
- navigating the hierarchy 37
- opening 37
- printing employee data 41
- search options 43
- searching for employees 42
- viewing employee data 39
- employee data
  - exporting 41
  - printing 41
  - viewing 39
- employee profiles 37
- employees
  - searching for 42
- exporting employee data 41
- geographic analysis 70
- organization analysis 58

## F
- filtering
  - geographic analysis 69
- Find People box 40
- folders
  - organization of 26
  - properties 30
- forecasting
  - graph types 86
  - in SAS Human Capital Management 85
  - overview 85
  - reports 86

## G
- geographic analysis 63
- copying 70
creating  67  
customizing  71  
defined  63  
exporting  70  
filtering  69  
map view  65  
printing  70  
search options  43  
table view  67  
geographic maps  23  
graphs  
displaying search results in  15  
types of  19  

H  
history  
Search History button  8  
Home page  2  
enabling search assist  9  
general search utility  5  
Manage list  4  
SAS HCM Content portlet  5  
Shortcuts list  5  
Tasks list  3  

I  
importing content  27  
information maps  
list, for default cubes  107  

L  
line charts  21  

M  
Manage list  4  
map view  
geographic analysis  65  
maps  
geographic  23  
measures  
predefined  121  
Saratoga Institute  121  

O  
organization analysis  49  
analysis view  51  
copying  57  
creating  53  
exporting  58  
modifying the organization structure  58  
overview  49  

P  
people  
Find People box  40  
pie charts  19  
portlet  
adding content to  29  
presentation view  
organization analysis  51  
printing  
employee data  41  
geographic analysis  70  
organization analysis  58  
properties  
setting document and folder properties  31  

Q  
Query tab  10  

R  
refreshing the workspace  27  
reports  
SAS reports  75  
SAS Web Report Studio  75  
standard  75  
stored processes  75  

S  
Saratoga Institute measures  121  
SAS BI Dashboard  
use in SAS Human Capital Management  91  
SAS Financial Management  117  
SAS for Workforce Planning & Budgeting  117  
SAS HCM Content portlet  5  
SAS Human Capital Management  1  
benefits  2  
SAS reports  
creating, in SAS Web Report Studio  97  
SAS Strategy Management  109  
SAS Web Report Studio  
example  98  
use in SAS Human Capital Management  
97, 107  
scatter plots  21  

Index
scorecards
  and SAS Human Capital Management 109
  creating 109
search assist 9
Search History button 8
search results 14
  displaying in graphs 15
searches
  advanced searches 9
  case-sensitive 10
Employee Browser options 43
  enabling search assist 9
  for employees 42
  general search 5, 7
  general search options 11
  geographic analysis options 43
  on default columns 8
Search History button 8
searching content 27
  simple searches 8
sharing content
  via e-mail 30
shortcuts
  creating 30
Shortcuts list 5
  simple searches 8
statistics
  displaying in organization analysis 55
stored processes
  forecasting 85
  supplemental schedules 118
T
table view
  geographic analysis 67
Tasks list 3
W
workspace 25
  adding content to portlet 29
  content management in 27
  creating shortcuts 30
  deleting content 30
  folder organization in 26
  importing content 27
  moving content 29
  refreshing 27
  searching for content 27
  setting document and folder properties 31
  sharing content via e-mail 30
Your Turn

We welcome your feedback.

• If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).
• If you have comments about the software, please send them to suggest@sas.com.